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1 คุณสมบตัิการวนิจิฉยัระบบคอมพิวเตอร

HP Insight Diagnostics
หมายเหต:ุ HP Insight Diagnostics จะรวมอยูในแผนซีดทีี่จัดสงไปพรอมกับคอมพิวเตอรบางรุน

ยูทิลิตี HP Insight Diagnostics ชวยใหคุณสามารถดูขอมูลเก่ียวกับการกําหนดคาฮารดแวรของคอมพิวเตอร และทําการ
ทดสอบวินิจฉัยฮารดแวรในระบบยอยของคอมพิวเตอร ยทูิลิตีน้ีจะชวยใหขั้นตอนการระบุอยางมีประสิทธิภาพ การวินิจฉัย
และการแยกปญหาฮารดแวร กระทําไดงายขึ้น

แท็บ Survey จะแสดงขึน้เม่ือคุณเรียกใชยทูิลิตี HP Insight Diagnostics แท็บน้ีจะแสดงการกําหนดคาปจจุบันของ
คอมพิวเตอร จากแท็บ Survey จะสามารถเขาสูประเภทขอมูลหลายกลุมเก่ียวกับคอมพิวเตอรน้ัน แท็บอ่ืนๆ จะใหขอมูลเพ่ิม
เติม รวมถึงตวัเลือกการทดสอบวินิจฉัยและผลลัพธการทดสอบ ขอมูลในแตละหนาจอของยูทิลิตีจะสามารถบันทึกเปนไฟล
html และจัดเก็บลงในดิสเก็ตตหรือแฟลชไดรฟ USB ได

ใช HP Insight Diagnostics เพื่อตรวจสอบวาอุปกรณทั้งหมดที่ตดิตั้งในระบบคอมพิวเตอรมีการรับรูภายในระบบและทํา
งานอยางถูกตอง การรันการทดสอบเปนส่ิงที่คุณเลือกปฏิบัติได แตขอแนะนําใหคณุกระทําทุกคร้ังที่ตดิตั้งหรือเชื่อมตอ
อุปกรณใหม

คุณควรทําการทดสอบ บันทึกผลการทดสอบ และพิมพออกมาเพื่อใหมีรายงานฉบับพิมพพรอมอยูกอนที่จะติดตอฝายบริการ
สนับสนุนลูกคา

หมายเหต:ุ HP Insight Diagnostics อาจตรวจไมพบอุปกรณของบริษัทอ่ืน

การเขาใช HP Insight Diagnostics
ในการเขาใช HP Insight Diagnostics คุณตองสรางชุดแผนดิสกสําหรับการเรียกคืน แลวบูตแผนซีดทีี่มียูทิลิตีน้ี คุณยงั
สามารถดาวนโหลดไดจาก http://www.hp.com โปรดด ูการดาวนโหลดเวอรชันลาสุดของยูทิลิตี HP Insight
Diagnostics ในหนา 5 สําหรับขอมูลเพ่ิมเติม

หมายเหต:ุ HP Insight Diagnostics จะรวมเปนสวนหน่ึงของชุดแผนดสิกสําหรับการเรียกคืนที่จัดสงไปพรอมกับ
คอมพิวเตอรบางรุน

หากคณุไดสรางชุดแผนดิสกสําหรับการเรียกคืน ใหเร่ิมตนที่ขั้นตอนที่ 4

1. คลิก Start > HP Backup and Recovery > HP Backup and Recovery Manager เพ่ือเปด Backup
and Recovery Wizard และคลิก Next

2. เลือก Create a set of recovery discs (Recommended) และคลิก Next

3. ใหทําตามคําแนะนําในวิซารดเพื่อสรางชุดแผนดสิกสําหรับการเรียกคืน

4. ใช Windows Explorer เพ่ือคนหาชุดแผนดกิสสําหรับการเรียกคืน สําหรับแผนซีดีดวยไดเรกทอรี
compaq\hpdiags

5. ขณะที่คอมพิวเตอรเปดอยู ใหใส แผนซีดีลงในไดรฟออปติคัลของคอมพิวเตอร
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6. ปดระบบปฏิบัติการและปดเคร่ืองคอมพิวเตอร

7. เปดเคร่ืองคอมพิวเตอร ระบบจะบูตจากแผนซีดี

หมายเหต:ุ หากระบบไมบูตจากแผนซีดีในไดรฟออปติคัล ทานอาจจําเปนตองเปล่ียนลําดบัการบูตในยูทิลิตีการตั้งคา
คอมพิวเตอร (F10) เพ่ือใหระบบพยายามบูตจากไดรฟออปติคัลกอนบูตจากฮารดไดรฟ โปรดดูรายละเอียดเพ่ิมเติม
ใน คูมือยทูิลิตีการตั้งคาคอมพิวเตอร (F10)

8. เลือกภาษาที่เหมาะสม และคลิก Continue

หมายเหต:ุ ขอแนะนําใหคุณยอมรับแปนพิมพตามที่กําหนดเปนคาดีฟอลตสําหรับภาษาของคุณ เวนแตคุณจะตอง
การทดสอบแปนพิมพเฉพาะ

9. ในหนา ขอตกลงเรื่องการอนุญาตใชสําหรับผูใช คลิกที่ Agree หากคุณยนิยอมในเง่ือนไข ยูทิลิตี HP Insight
Diagnostics จะถูกเรียกทํางานพรอมกับมีแท็บ Survey แสดงขึ้น

แทบ็ Survey
แท็บ Survey จะแสดงขอมูลการกําหนดคาสําคัญของระบบ

ในสวน View level คุณสามารถเลือกมุมมอง Summary เพ่ือดูขอมูลการกําหนดคาบางอยาง หรือเลือกมุมมอง
Advanced เพ่ือดขูอมูลทั้งหมดในประเภทที่เลือก

ในสวน Category คุณสามารถเลือกใหแสดงผลขอมูลตอไปน้ี:

All — แสดงรายการประเภทขอมูลหลายกลุมเก่ียวกับคอมพิวเตอรน้ัน

Overview — แสดงรายการขอมูลทั่วไปเก่ียวกับคอมพิวเตอรของคุณ

สถาปตยกรรม — ใหขอมูล BIOS ระบบ และอุปกรณ PCI

Asset Control — แสดงชือ่ผลิตภัณฑ แท็กสินทรัพย หมายเลขซีเรียลระบบ และขอมูลโปรเซสเซอร

Communication — แสดงขอมูลเก่ียวกับการตัง้คาพอรตขนาน (LPT) และพอรตอนุกรม (COM) ของคอมพิวเตอร รวม
ถึงขอมูลเน็ตเวิรกคอนโทรลเลอร และ USB

Graphics — แสดงขอมูลเก่ียวกับคอนโทรลเลอรแสดงผลกราฟกของคอมพิวเตอร

Input Devices — แสดงขอมูลเก่ียวกับแปนพิมพ เมาส และอุปกรณอินพุทอ่ืนๆ

Memory — แสดงขอมูลเก่ียวกับหนวยความจําในคอมพิวเตอร ซ่ึงรวมถึงสล็อตหนวยความจําบนเมนบอรดและโมดลูหนวย
ความจําที่ติดตั้ง

Miscellaneous — แสดงขอมูลรุนของ HP Insight Diagnostics ขอมูลหนวยความจําการกําหนดคาคอมพิวเตอร
(CMOS) ขอมูลเมนบอรด และขอมูล BIOS การจัดการระบบ

Storage — แสดงขอมูลเก่ียวกับส่ือจัดเก็บขอมูลที่เชื่อมตอกับคอมพิวเตอร ซ่ึงรวมถึงดิสกทั้งหมดที่ตดิตัง้ ดสิเก็ตตไดรฟ
และไดรฟออปติคัล

System — แสดงขอมูลเก่ียวกับรุนของคอมพิวเตอร โปรเซสเซอร โครงเคร่ือง และ BIOS รวมถึงลําโพงภายในและขอมูล
บัส PCI
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แทบ็ Test
แท็บ Test ชวยใหคุณสามารถเลือกทดสอบสวนตางๆ ของระบบได อีกทั้งสามารถเลือกประเภทและโหมดของการทดสอบได

โหมดการทดสอบมีใหเลือกสองโหมดคือ:

● Quick Test - แสดงสคริปตที่กําหนดไวลวงหนา เม่ือมีการทดสอบตัวอยางของสวนประกอบฮารดแวรแตละชิน้ และ
ไมตองการการแทรกแซงจากผูใช ไมวาในโหมด Unattended หรือ Interactive ยกเวนสําหรับแปนพิมพและ
อุปกรณเมาส

● Complete Test - แสดงสคริปตที่กําหนดไวลวงหนา โดยที่สวนประกอบฮารดแวรแตละชิ้นจะถูกทดสอบอยางเต็มที่
ยงัมีการทดสอบอีกหลายแบบใหเลือกไดในโหมด Interactive แตจําเปนตองไดรับการแทรกแซงจากผูใช

● Custom Test - ใหความยดืหยุนมากที่สุดสําหรับการควบคุมการทดสอบระบบ โหมด Custom Test ชวยใหคณุ
สามารถเลือกอุปกรณ การทดสอบ และพารามิเตอรการทดสอบที่จะใช ไดเปนการเฉพาะ

โหมดการทดสอบมีใหเลือกสองโหมดสําหรับการทดสอบแตละประเภท:

● Interactive Mode - ใหการควบคมุขั้นตอนการทดสอบไดสูงสุด ซอฟตแวรวินิจฉัยจะใหคณุปอนขอมูลระหวางการ
ทดสอบท่ีตองการการตอบสนองจากคณุ คณุยังอาจตรวจสอบไดวาการทดสอบน้ันผานหรือไมผาน

● Unattended Mode - ไมแสดงการแจงและไมตองการขอมูลจากคุณ ในกรณีที่พบขอผิดพลาด จะปรากฏขอความ
ระบุถึงขอผิดพลาดหลังจากที่การทดสอบเสร็จส้ินลง

ในการเริ่มตนการทดสอบ:

1. เลือกแท็บ Test

2. เลือกแท็บชนิดของการทดสอบที่คุณตองการรัน: Quick, Complete หรือ Custom

3. เลือก Test Mode: Interactive หรือ Unattended

4. เลือกวิธกีารส่ังการทดสอบที่คุณตอง โดยมีแบบ Number of Loops หรือ Total Test Time เม่ือเลือกรันการทด
สอบตามลําดบัการวนที่ระบุ ใหปอนจํานวนการวนที่จะดําเนินการ หากคุณตองการใหการวินิจฉัยทดสอบตามชวงเวลาที่
ระบุ ใหปอนจํานวนเวลาเปนนาที

5. หากคุณเลือกทําการทดสอบแบบ Quick Test หรือ Complete Test ใหเลือกอุปกรณที่ตองการทดสอบจากรายการ
ตรวจสอบ หากคุณเลือกทําการทดสอบแบบ Custom Test ใหคลิกปุม Expand และเลือกอุปกรณที่ตองการทดสอบ
หรือคลิกปุม Check All เพ่ือเลือกอุปกรณทั้งหมด

6. คลิกปุม Begin Testing ที่มุมขวาลางของหนาจอเพื่อเร่ิมตนการทดสอบ แท็บ Status ซ่ึงชวยใหคุณตรวจดูความคืบ
หนาของการทดสอบ จะแสดงขึ้นโดยอัตโนมัตริะหวางขั้นตอนการทดสอบ เม่ือการทดสอบเสร็จส้ิน แท็บ Status จะ
แสดงวาอุปกรณผานหรือไมผาน

7. หากตรวจพบขอผิดพลาด ใหไปที่แท็บ Log และคลิกที่ Error Log เพ่ือแสดงขอมูลเพ่ิมเตมิโดยละเอียดและมาตรการ
ที่แนะนํา

แทบ็ Status
แท็บ Status จะแสดงสถานะของการทดสอบที่เลือก ประเภทของการทดสอบที่ดําเนินการ (Quick, Complete หรือ
Custom) จะแสดงขึ้นเชนกัน แถบความคืบหนาหลักจะแสดงเปอรเซ็นตที่ทําเสร็จของชุดการทดสอบปจจุบัน ขณะที่อยู
ระหวางการทดสอบ ปุม Cancel Testing จะแสดงขึน้เพ่ือใหใชในกรณีที่คุณตองการยกเลิกการทดสอบ

หลังจากทดสอบเสร็จส้ิน ปุม Cancel Testing จะถูกแทนที่ดวยปุม Retest ปุม Retest จะทดสอบชุดการทดสอบลาสุดอีก
คร้ัง วิธีน้ีชวยใหคุณสามารถทําการทดสอบซ้ําโดยไมตองปอนขอมูลอีกคร้ังในแท็บ Test
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แท็บ Status ยงัจะแสดง:

● อุปกรณที่ถูกทดสอบ

● สถานะของการทดสอบ (กําลังทดสอบ ผานหรือไมผาน) ของแตละอุปกรณที่ทําการทดสอบ

● ความคืบหนาโดยรวมของการทดสอบสําหรับทุกอุปกรณที่กําลังทําการทดสอบ

● ความคืบหนาของการทดสอบสําหรับแตละอุปกรณที่กําลังทําการทดสอบ

● เวลาทดสอบที่ใชสําหรับแตละอุปกรณที่กําลังทําการทดสอบ

แทบ็ Log
แท็บ Log มีแท็บ Test Log และแท็บ Error Log อยูภายใน

Test Log จะแสดงการทดสอบทั้งหมดที่ดําเนินการไปแลว จํานวนคร้ังของการดําเนินการ จํานวนคร้ังที่การทดสอบลมเหลว
และเวลาที่ใชในการทดสอบแตละคร้ังจนเสร็จส้ิน ปุม Clear Test Log จะลบเน้ือหาทั้งหมดของ Test Log

Error Log จะแสดงการทดสอบของอุปกรณที่ลมเหลวระหวางการทดสอบวินิจฉัย และรวมถึงขอมูลคอลัมนตอไปน้ี

● สวน Device จะแสดงอุปกรณที่ทําการทดสอบแลว

● สวน Test จะแสดงประเภทของการทดสอบที่ใช

● สวน Description จะแสดงรายละเอียดขอผิดพลาดที่พบในการทดสอบวินิจฉัย

● Recommended Repair คอืการแกไขที่แนะนํา ซ่ึงควรดําเนินการเพื่อแกไขปญหาฮารดแวรลมเหลว

● Failed Count คือจํานวนคร้ังที่อุปกรณไมผานการทดสอบ

● Error Code แจงรหัสตัวเลขของความลมเหลว รหัสขอผิดพลาดมีระบุไวในแท็บ Help

ปุม Clear Error Log จะลบเน้ือหาทั้งหมดของ Error Log

แทบ็ Help
แท็บ Help จะมีทั้งแท็บ HP Insight Diagnostics แท็บ Error Codes และแท็บ Test Components

แท็บ HP Insight Diagnostics ประกอบดวยหัวขอความชวยเหลือ รวมทั้งคณุสมบัติในการคนหาและดัชนี

แท็บ Error Codes จะใหขอมูลรายละเอียดของรหัสขอผิดพลาดที่แสดงเปนตัวเลขแตละรหัสที่อาจปรากฏในแท็บ Error
Log บนแท็บ Log รหัสแตละตัวมี Message แสดงขอผิดพลาดที่ตรงกันและ Recommended Repair หรือส่ิงที่ควรทํา
ที่อาจชวยแกปญหา สําหรับการคนหาคําอธิบายรหัสขอผิดพลาดอยางรวดเร็ว ใหปอนรหัสในกลองที่ดานบนของแท็บ และ
คลิกปุม Find Error Codes

แท็บ Test Components จะแสดงขอมูลระดับลางของการทดสอบที่กําลังทําอยู

การบันทกึและการพมิพขอมลูใน HP Insight Diagnostics
คุณสามารถบันทึกขอมูลที่แสดงในแท็บ HP Insight Diagnostics Survey และแท็บ Log ลงในแผน
ดิสเก็ตตหรือแฟลชไดรฟ USB 2.0 (64MB ขึ้นไป) คณุไมสามารถบันทึกลงในฮารดไดรฟ ระบบจะสรางไฟล html โดย
อัตโนมัติ ซ่ึงจะมีลักษณะเหมือนกับขอมูลที่แสดงที่หนาจอ

1. ใสแผนดิสเก็ตตหรือแฟลชไดรฟ USB 2.0 (ตองมีความจุ 64MB ขึ้นไป) ไมสนับสนุนแฟลชไดรฟ USB 1.0

2. คลิก Save ที่มุมขวาลางของหนาจอ

3. เลือก Save to the floppy หรือ Save to USB key
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4. ปอนชื่อไฟลในกลอง File Name และคลิกปุม Save ไฟล html จะถูกบันทึกในแผนดิสเก็ตตที่ใสไวหรือแฟลชไดรฟ
USB

หมายเหต:ุ หามดึงแผนดิสเก็ตตหรือ USB คียออกจนกวาคุณจะเห็นขอความที่แจงวา ไฟล html ถูกเขยีนลงไปที่ส่ือ
แลว

5. พิมพขอมูลจากอุปกรณส่ือจัดเก็บที่ใชบันทึกไฟลน้ัน

หมายเหต:ุ หากตองการออกจากยูทิลิต ีHP Insight Diagnostics คลิกที่ปุม Exit Diagnostics ตรงมุมซายลางของหนา
จอ กอนดึง แผนซีดีออกจากไดรฟออปตคิัล

การดาวนโหลดเวอรชนัลาสดุของยทูลิติ ีHP Insight Diagnostics
1. ไปที่ http://www.hp.com

2. คลิกที่ลิงค Software & Drivers

3. เลือก Download drivers and software (and firmware)

4. ปอนหมายเลขผลิตภัณฑ (ตัวอยางเชน dc7900) ลงในกลองขอความและกดปุม Enter

5. เลือกรุนคอมพิวเตอรของคุณ

6. เลือกระบบปฏิบัตกิารของคุณ

7. คลิกที่ลิงค Diagnostic

8. คลิกที่ HP Insight Diagnostics Offline Edition

9. คลิกปุม Download

หมายเหต:ุ การดาวนโหลดจะรวมคําแนะนําวิธกีารสรางซีดีที่สามารถบูตไดไวดวย

การปองกนัซอฟตแวร
ในการปองกันความเสียหายหรือการสูญหายของซอฟตแวร คณุควรเก็บรักษาสําเนาของไฟลระบบ แอปพลิเคชนั และไฟลที่
เก่ียวของที่เก็บไวในฮารดไดรฟทั้งหมดไว โปรดดูเอกสารของระบบปฏิบัติการหรือยูทิลิตีสํารองขอมูล เพ่ือดูคําแนะนําเก่ียว
กับการสํารองไฟลขอมูล
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HP Backup and Recovery Manager
HP Backup and Recovery Manager เปนแอปพลิเคชันที่ใชไดงาย และมีประโยชนที่อนุญาตใหคุณสํารองขอมูลและ
เรียกคนืฮารดไดรฟหลักบนคอมพิวเตอร แอปพลิเคชันที่ทํางานภายใน Windows เพ่ือสรางการสํารองขอมูลของ Windows
แอปพลิเคชันทั้งหมด และไฟลขอมูลทั้งหมด คณุอาจกําหนดเวลาใหเคร่ืองทําการสํารองขอมูลใหโดยอัตโนมัต ิหรือเลือกทํา
การสํารองดวยตัวคุณเอง ไฟลที่สําคัญสามารถจัดเก็บแยกตางหากจาการสํารองขอมูลปกติ

HP Backup and Recovery Manager ที่ติดตั้งไวลวงหนาบน Recovery Partition ของฮารดไดรฟและอนุญาตให
คุณ:

จุดการกูคืนและการสํารองไฟลสามารถทําการคัดลอกลงแผนซีดหีรือแผนดีวีดี ขณะที่การสํารองขอมูลทั้งหมดสามารถคัดลอก
ไปยังเครือขายหรือฮารดดกิสตัวท่ีสอง

HP ขอแนะนําใหคณุสรางชดุแผนดิสกสําหรับการเรียกคนืทันทีหลังจากใชคอมพิวเตอร และกําหนดเวลาสํารองขอมูลแบบ
Recovery Point โดยอัตโนมัตอิยางสมํ่าเสมอ

ในการสรางชุดแผนดสิกสําหรับการเรียกคืน:

1. คลิก Start > HP Backup and Recovery > HP Backup and Recovery Manager เพ่ือเปด Backup
and Recovery Wizard และคลิก Next

2. เลือก Create a set of recovery discs (Recommended) และคลิก Next.

3. ปฏิบัตติามคําแนะนําในวิซารด

สําหรับขอมูลเพ่ิมเติมเก่ียวกับการใช HP Backup and Recovery Manager โปรดดูที่ คูมือผูใชตวัจัดการการสํารองและ
การเรียกขอมูลคืน ดวยการเลือก Start > HP Backup and Recovery > HP Backup and Recovery Manager
Manual

หมายเหต:ุ คุณสามารถส่ังซ้ือชดุแผนดิสกสําหรับการเรียกคนืไดจาก HP ดวยการติดตอฝายบริการสนับสนุนของ HP ทาง
โทรศพัท ไปที่เว็บไซตตอไปน้ี เลือกประเทศ/พ้ืนที่ของคุณ และคลิกที่ลิงค Technical support after you buy ใตหัว
ขอ Call HP เพ่ือรับหมายเลขโทรศัพทของฝายบริการสนับสนุนของประเทศ/พ้ืนที่ของคณุ

http://welcome.hp.com/country/us/en/wwcontact_us.html
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http://welcome.hp.com/country/us/en/wwcontact_us.html


2 การแกไขปญหาโดยไมผานโปรแกรมวนิจิฉยั

บทน้ีจะใหขอมูลเก่ียวกับการระบุและการแกไขปญหาทีไ่มรายแรง เชน ปญหาที่เก่ียวกับดิสเก็ตตไดรฟ ฮารดไดรฟ
ไดรฟออปติคลั กราฟก หนวยความจํา และซอฟตแวร หากคุณพบปญหาเก่ียวกับเคร่ืองคอมพิวเตอร โปรดอางอิงตารางในบท
น้ีเพ่ือดูรายละเอียดเก่ียวกับสาเหตทุี่เปนไปไดและวิธีแกไขที่แนะนํา

หมายเหต:ุ สําหรับขอมูลเก่ียวกับขอความแสดงขอผดิพลาดที่อาจปรากฏบนหนาจอระหวางการทดสอบเริ่มทํางานดวยตน
เอง (Power On Self Test \endash POST) โปรดดูที่ภาคผนวก A ขอความแสดงขอผิดพลาดของ POST
ในหนา 48

ความสะดวกและความปลอดภยั
คาํเตอืน! การใชคอมพิวเตอรอยางผิดวิธีหรือการติดตั้งในสภาพแวดลอมการทํางานที่ไมปลอดภัยและไมเหมาะสม อาจกอ
ใหเกิดปญหาการใชงานไมสะดวกหรือเปนอันตรายรายแรงได โปรดดขูอมูลเพิ่มเติมเก่ียวกับการเลือกสภาพแวดลอมในการ
ทํางานท่ีปลอดภัยและสะดวกสบายที ่คูมือเพ่ือความสะดวกและความปลอดภัย บนเว็บไซต http://www.hp.com/ergo
อุปกรณน้ีไดผานการตรวจสอบและเปนไปตามขอกําหนดสําหรับอุปกรณดจิิตอลคลาส B ตามขอกําหนดบทที่ 15 ของ FCC
โปรดดูขอมูลเพ่ิมเติมในคูมือ ขอมูลเก่ียวกับความปลอดภัยและขอบังคับตางๆ

กอนทีจ่ะตดิตอฝายสนบัสนนุดานเทคนคิ
หากคณุพบปญหาเก่ียวกับเคร่ืองคอมพิวเตอร ใหลองใชวิธีแกไขตอไปน้ีเพ่ือแยกปญหาที่แกไขไมได กอนที่จะติดตอขอรับ
บริการสนับสนุนดานเทคนิค

● รันเคร่ืองมือการวินิจฉัยปญหาของ HP

● รันการทดสอบระบบของฮารดไดรฟในการตัง้คาคอมพิวเตอร โปรดดรูายละเอียดเพ่ิมเติมใน คูมือยูทิลิตีการตั้งคา
คอมพิวเตอร (F10)

● ตรวจสอบไฟสถานะเปดเคร่ืองท่ีดานหนาของเคร่ืองคอมพิวเตอร เพื่อดูวาไฟกะพริบเปนสีแดงหรือไม ไฟที่กะพริบคอื
รหัสขอผิดพลาดที่จะชวยคุณวินิจฉัยปญหาที่เกิดขึ้น โปรดดูขอมูลเพ่ิมเติมในภาคผนวก A ขอความแสดงขอผดิพลาด
ของ POST ในหนา 48

● หากหนาจอวางเปลาปรากฏ ใหเสียบปล๊ักของจอภาพลงในพอรตวิดีโอพอรตอ่ืนบนคอมพิวเตอรหากมีพอรตน้ันอยู หรือ
เปล่ียนไปใชจอภาพที่คณุแนใจวาทํางานเปนปกติ

● หากคุณทํางานบนระบบเน็ตเวิรก ใหเสียบคอมพิวเตอรอีกเคร่ืองหน่ึงพรอมสายเคเบิลสายอ่ืนลงในระบบการเชื่อมตอ
ของเน็ตเวิรก ปญหาอาจอยูที่ปล๊ักหรือสายเคเบิลของระบบเน็ตเวิรก

● หากคุณเพ่ิงเพ่ิมฮารดแวรใหมลงไป ใหถอดฮารดแวรน้ันออก และดูวาคอมพิวเตอรทํางานไดอยางเหมาะสมหรือไม

● หากคุณเพ่ิงติดตั้งซอฟตแวรใหมลงไป ใหลบซอฟตแวรน้ันออกจากเครื่อง และดูวาคอมพิวเตอรทํางานไดอยางเหมาะ
สมหรือไม

● บูตคอมพิวเตอรมาที่ Safe Mode เพ่ือดวูาคอมพิวเตอรจะบูตขึน้มาหรือไมหากไมไดโหลดไดรเวอรทั้งหมด เม่ือบูต
ระบบปฏิบัติการ ใหใช “Last Known Configuration”

THWW ความสะดวกและความปลอดภัย 7
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● โปรดติดตอฝายสนับสนุนทางเทคนิคทางออนไลนไดที่ http://www.hp.com/support

● โปรดดู คําแนะนํา ในหนา 8 ในคูมือน้ี

HP Instant Support Professional Edition ไดจัดเตรียมการวินิจฉัยเพ่ือการแกปญหาไวใหกับคุณเพ่ือชวยคุณแกปญหา
แบบออนไลน หากคณุตองการติดตอบริการสนับสนุนของ HP ใหใชคณุสมบัติการสนทนาออนไลนของ HP Instant
Support Professional Edition โดยเขาใชงาน HP Instant Support Professional Edition ไดที่:
http://www.hp.com/go/ispe

เชื่อมตอเขาสู Business Support Center (BSC) ที่ http://www.hp.com/go/bizsupport เพ่ือดูขอมูลลาสุดเก่ียวกับ
การสนับสนุนแบบออนไลน ซอฟตแวรและไดรเวอร การแจงเตือนลวงหนา และชุมชนผูใชและผูเชี่ยวชาญของ HP ทั่วโลก

หากคุณจําเปนตองโทรศพัทตดิตอเพ่ือขอความชวยเหลือดานเทคนิค โปรดปฏิบัติตามขั้นตอนตอไปน้ีเพ่ือใหคุณไดรับการ
บริการอยางเหมาะสม:

● อยูหนาคอมพิวเตอรในขณะที่โทรติดตอ

● จดซีเรียลนัมเบอรของคอมพิวเตอร, เลขที่ ID ของผลิตภัณฑ และซีเรียลนัมเบอรของจอภาพ กอนที่จะโทรศัพท

● เวลาที่ใชแกปญหารวมกับชางเทคนิค

● ถอดฮารดแวรที่เพ่ิงเพ่ิมลงในระบบออกไปกอน

● ลบซอฟตแวรที่เพ่ิงติดตัง้ออกไปกอน

● เรียกคืนระบบจากชุดแผนดิสกสําหรับการเรียกคืนที่คณุสรางขึ้นหรือเรียกคนืระบบกบลับมาเปนสภาพเดิมจากโรงงาน
ที่อยูใน HP Backup and Recovery Manager

ขอควรระวัง: การเรียกคืนระบบจะลบขอมูลทั้งหมดบนฮารดไดรฟ ตองแนใจวาไดสํารองขอมูลในไฟลขอมูลทั้งหมดเก็บไว
กอนรันขั้นตอนการเรียกคนื

หมายเหต:ุ สําหรับขอมูลเก่ียวกับการขายและการเพิ่มการรับประกัน (Care Packs) โปรดติดตอตัวแทนจําหนายหรือผูให
บริการที่ไดรับอนุญาตในพ้ืนที่ของคุณ

คาํแนะนํา
หากคุณพบปญหาเก่ียวกับคอมพิวเตอร จอภาพ หรือซอฟตแวร โปรดดูที่รายการคําแนะนําโดยทั่วไปตอไปน้ีกอนดําเนินการ
ใดๆ ตอ:

● ตรวจสอบวาคอมพิวเตอรและจอภาพตอเขากับเตาเสียบที่มีกระแสไฟฟา

● ตรวจสอบวาสวิตชเลือกระดบัแรงดันไฟฟาอยูในตําแหนงของระดับแรงดนัไฟฟาที่ถูกตองสําหรับพ้ืนที่ที่คุณอาศัยอยู
(115V หรือ 230V)

● ตรวจสอบวา ไดเปดคอมพิวเตอรแลวและไฟเพาเวอรสีเขียวติดสวาง

● ตรวจสอบวา ไดเปดจอภาพแลวและไฟจอภาพสีเขียวติดสวาง

● ตรวจสอบไฟสถานะเปดเคร่ืองที่ดานหนาของเคร่ืองคอมพิวเตอร เพ่ือดูวาไฟกะพริบเปนสีแดงหรือไม ไฟที่กะพริบคอื
รหัสขอผิดพลาดที่จะชวยคุณวินิจฉัยปญหาที่เกิดขึ้น โปรดดูขอมูลเพ่ิมเติมในภาคผนวก A ขอความแสดงขอผิดพลาด
ของ POST ในหนา 48

● ปรับปุมควบคุมความสวางและความคมชดัของจอภาพหากจอภาพเปนสีจาง

● กดปุมใดปุมหน่ึงคางไว หากระบบสงเสียงบ๊ีป แสดงวาแปนพิมพทํางานตามปกติ

● ตรวจสอบวาจุดเชือ่มตอสายเคเบิลทั้งหมดไมหลุดหลวมหรือเชือ่มตอไมถูกตอง

8 บท 2   การแกไขปญหาโดยไมผานโปรแกรมวินิจฉัย THWW

http://www.hp.com/support
http://www.hp.com/go/ispe
http://www.hp.com/go/bizsupport


● เรียกใชคอมพิวเตอรไดดวยการกดปุมใดก็ไดบนแปนพิมพหรือกดปุมเพาเวอร หากเคร่ืองคอมพิวเตอรยังคงอยูใน
โหมดพักการใชงาน ใหปดเคร่ืองโดยใชวิธีกดปุมเพาเวอรคางไวอยางนอย 4 วินาที จากน้ันใหกดปุมเพาเวอรอีกคร้ัง
เพ่ือรีสตารทคอมพิวเตอร หากระบบคางไมยอมปด ใหถอดปล๊ัก รอประมาณ 1-2 วินาที และเสียบปล๊ักใหมอีกคร้ัง
คอมพิวเตอรจะเร่ิมใหมหากถูกตัง้คาใหเปดอัตโนมัติทันทีที่เพาเวอรถูกกูคืนในการตัง้คาคอมพิวเตอร หากคอมพิวเตอร
ไมเร่ิมการทํางานใหมอีกคร้ัง ใหกดปุมเพาเวอรเพ่ือเร่ิมการทํางานของคอมพิวเตอร

● ตัง้คาเคร่ืองคอมพิวเตอรใหมหลังจากติดตั้งการดเอ็กซแพนชนัหรืออุปกรณเสริมที่ไมใชแบบ Plug and Play โปรดดู
คําแนะนําใน การแกไขปญหาในการติดตั้งฮารดแวร ในหนา 32

● ตรวจสอบใหแนใจวา ไดติดตัง้ไดรเวอรอุปกรณทั้งหมดที่จําเปนแลว ตัวอยางเชน หากคณุกําลังใชเคร่ืองพิมพ คุณตอง
ใชไดรเวอรสําหรับเคร่ืองพิมพในรุนน้ัน

● ยายส่ือที่ใชบูตระบบทั้งหมด (แผนดิสก ซีดีหรืออุปกรณ USB) ออกจากระบบกอนเปดเคร่ือง

● หากคุณไดตดิตั้งระบบปฏิบัตกิารอ่ืนที่ไมใชระบบที่ติดตั้งมาจากโรงงาน โปรดตรวจสอบวาระบบน้ันสามารถทํางานได
ในเคร่ืองคอมพิวเตอรของคุณ

● หากระบบมีอุปกรณแหลงสัญญาณภาพหลายตวั (อะแดปเตอรภายใน, PCI หรือ PCI-Express) ติดตัง้อยู (วิดีโอแบบ
ตดิตั้งภายในมีในบางรุนเทาน้ัน) และมีจอภาพเพียงเคร่ืองเดียว จอภาพดังกลาวจะตองตอเขากับชองเสียบจอภาพบน
แหลงสัญญาณภาพที่คุณเลือกเปนอะแดปเตอร VGA หลัก ในระหวางการบูตเคร่ือง ชองเสียบจอภาพอ่ืนจะถูกปด และ
หากตอจอภาพเขากับพอรตเหลาน้ี จอภาพจะไมทํางาน คุณสามารถเลือกแหลงสัญญาณภาพที่เปนคาดฟีอลตสําหรับ
แหลงสัญญาณ VGA ไดในโปรแกรมการตั้งคาคอมพิวเตอร

ขอควรระวงั: เม่ือตอสายไฟกับเคร่ืองคอมพิวเตอร แหลงจายไฟจะมีแรงดันไฟฟาสําหรับเมนบอรดอยูตลอดเวลา คุณตอง
ถอดสายไฟออกจากเตาเสียบกอนที่จะเปดฝาเคร่ืองคอมพิวเตอรเพ่ือปองกันความเสียหายกับเมนบอรดหรือสวนประกอบภาย
ในเคร่ือง

THWW คําแนะนํา 9



การแกปญหาทัว่ไป
คุณสามารถแกไขปญหาทั่วไปตามที่อธิบายไวในหัวขอน้ีไดอยางงายดาย หากปญหายังคงอยูและคุณไมสามารถแกไขไดดวย
ตนเอง หรือหากคุณไมตองการดําเนินการดวยตนเอง โปรดติดตอผูขายหรือตัวแทนจําหนายที่ไดรับอนุญาต

คาํเตอืน! เม่ือตอสายไฟกับเคร่ืองคอมพิวเตอร แหลงจายไฟจะมีแรงดันไฟฟาสําหรับเมนบอรดอยูตลอดเวลา เพ่ือลดความ
เส่ียงที่จะไดรับบาดเจ็บจากไฟฟาช็อต และ/หรือพ้ืนผวิที่รอน คณุควรตรวจดใูหแนใจวา ไดถอดปล๊ักไฟแลว และปลอยใหสวน
ประกอบภายในของระบบเยน็กอนจะสัมผัส

ตาราง 2-1  การแกปญหาทัว่ไป

คอมพวิเตอรคางและไมยอมปดลงเมือ่กดปุมเพาเวอร

สาเหตุ วธิแีกไข

ระบบควบคุมสวิตชเพาเวอรดวยซอฟตแวรไมทํางาน 1. กดปุมเพาเวอรคางไวเปนเวลาอยางนอย 4 วินาท ีจนกระทัง่เคร่ือง
คอมพิวเตอรปดลง

2. ถอดสายไฟออกจากเตารับไฟฟา

คอมพวิเตอรไมสนองตอบกบัแปนพมิพหรอืเมาส USB

สาเหตุ วธิแีกไข

คอมพิวเตอรอยูในโหมด สแตนดบาย หากตองการออกจากโหมด สแตนดบาย ใหกดทีปุ่มเพาเวอรหรือปุมใดกไ็ด

ขอควรระวงั: เมื่อพยายามจะทํางานตอจากโหมด สแตนดบาย อยากดปุม
เพาเวอรนานเกินสี่วินาท ีมิฉะนั้น คอมพวิเตอรจะปดลง และคณุจะสูญเสีย
ขอมูลที่ยงัไมไดจัดเกบ็

ระบบคาง รีสตารทคอมพวิเตอร

เครือ่งคอมพวิเตอรแสดงวนัทีแ่ละเวลาไมถกูตอง

สาเหตุ วธิแีกไข

คณุอาจตองเปลี่ยนแบตเตอรี่ของนาฬิกาภายในระบบ (RTC - real-time
clock)

หมายเหต:ุ การเสียบปล๊ักคอมพิวเตอรเขากบัเตารับไฟฟาจะชวยยดือายุ
การใชงานของแบตเตอรี่ RTC

ขัน้แรก ใหรีเซ็ตวันที่และเวลาที ่Control Panel (หรืออาจใชยูทลิิตีการตัง้
คาคอมพิวเตอรเพ่ืออัพเดตวันทีแ่ละเวลาของ RTC) หากปญหายังคงอยู ให
เปล่ียนแบตเตอรี่ RTC โปรดด ูคูมืออางอิงเกีย่วกบัฮารดแวร เพือ่ดูคาํแนะ
นาํเกีย่วกบัการติดตั้งแบตเตอร่ีใหม หรือตดิตอตวัแทนจําหนายหรือผูขายที่
ไดรับอนญุาตเพือ่ขอคําแนะนําในการเปลี่ยนแบตเตอรี่

เคอรเซอรไมเคลือ่นไหวเมือ่ใชปุม ลูกศร บนแปนพมิพ

สาเหตุ วธิแีกไข

ปุม Num Lock อาจอยูในสถานะใชงาน กดปุม Num Lock ไฟสถานะ Num Lock ไมควรจะเปดอยูหากคณุตอง
การใชปุม ลูกศร สามารถเปด (หรือปดการใชงาน) ปุม Num Lock ไดใน
ยทูลิิตีการตัง้คาคอมพวิเตอร
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ไมมเีสยีงหรือระดบัเสยีงเบามาก

สาเหตุ วธิแีกไข

ระดบัเสียงของเครื่องอาจจะถกูตัง้ใหเบาหรือปดเสียง 1. ตรวจสอบการตัง้คา F10 BIOS เพือ่ใหแนใจไดวาลําโพงภายใน
เคร่ืองไมไดปดเสียงไว (การตั้งคานีจ้ะไมมีผลกบัลําโพงภายนอก)

2. ตรวจสอบใหแนใจวา ลําโพงภายนอกไดเชื่อมตอไวถกูตองหรือไม
และเปดเคร่ืองและตั้งคาระดบัเสียงของลําโพงไดอยางถกูตอง

3. ใชตัวควบคมุเสียงทีม่ีอยูในระบบปฏิบตักิารเพือ่ใหแนใจวาลําโพงไม
ไดถกูปดเสียง หรือเพ่ิมระดับเสียง

ไมสามารถถอดฝาครอบคอมพวิเตอรหรอืแผงปดดานขางได

สาเหตุ วธิแีกไข

มกีารล็อคดวยคณุสมบัตล็ิอค Smart Cover ในคอมพิวเตอรบางเคร่ือง ปลดล็อค Smart Cover โดยใชยูทลิิตกีารตั้งคาคอมพวิเตอร

คณุสามารถซื้อกญุแจ Smart cover FailSafe สําหรับปลดล็อค Smart
Cover ไดจาก HP คุณจะตองใชปุม FailSafe ในกรณีทีค่ณุลืมรหสัผาน
ไฟดบั หรือคอมพวิเตอรทํางานผิดปกต ิสั่งซื้อ PN 166527-001 สําหรับ
กญุแจแบบประแจ หรือ PN 166527-002 สําหรับกญุแจแบบไขควง

มกีารทาํงานอยางไมเตม็ประสิทธภิาพ

สาเหตุ วธิแีกไข

โปรเซสเซอรมีอุณหภูมิสูง 1. ดใูหแนใจวาชองระบายอากาศไมถกูปดกัน้ เวนพืน้ทีว่างประมาณ
10.2 ซม. (4 นิ้ว) ทกุดานทีม่ีทางระบายอากาศของเคร่ือง
คอมพวิเตอรและดานบนของจอภาพเพือ่ใหอากาศถายเทไดสะดวก

2. ตรวจดวูาพดัลมถกูเชือ่มตอและทํางานอยางถกูตอง (พัดลมบางตัวทํา
งานเมื่อจําเปนเทานัน้)

3. ตรวจสอบวาตัวระบายความรอนของโปรเซสเซอรถกูติดตั้งอยางถูก
ตอง

ฮารดไดรฟเตม็ ถายโอนขอมูลจากฮารดไดรฟ เพือ่เพิ่มพืน้ทีว่างบนฮารดไดรฟ

หนวยความจําเหลือนอย เพิม่หนวยความจํา

ขอมูลบนฮารดไดรฟกระจัดกระจาย ดแีฟรกฮารดไดรฟ

โปรแกรมที่เรียกใชงานกอนหนานีไ้มปลอยหนวยความจําทีส่ํารองไวกลับ
คนืสูระบบ

เร่ิมการทํางานของคอมพิวเตอรใหม

มีไวรัสบนฮารดไดรฟ รันโปรแกรมปองกนัไวรัส

รันแอปพลิเคชนัมากเกนิไป 1. ปดแอปพลิเคชันทีไ่มจําเปนเพื่อเพ่ิมหนวยความจํา

2. เพิม่หนวยความจํา บางโปรแกรมรันในพื้นหลังและสามารถปดโดย
การคลิกขวาทีไ่อคอนทีเ่กีย่วของในถาดงาน ในการปองกันไมให
โปรแกรมเหลานีท้ํางานเมื่อเร่ิมตนระบบ ใหไปที ่Start > Run
(Windows XP) หรือ Start > Accessories > Run (Windows
Vista) และพิมพ msconfig ทีแ่ท็บ Startup ของ System
Configuration Utility ใหลบโปรแกรมทีค่ณุไมตองการใหเปดโดย
อัตโนมัติ

ตาราง 2-1  การแกปญหาทั่วไป (ตอ)
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มกีารทาํงานอยางไมเตม็ประสทิธภิาพ

สาเหตุ วธิแีกไข

แอปพลิเคชัน่ซอฟตแวรบางประเภท โดยเฉพาะเกมส จะใชระบบยอยการ
แสดงผลกราฟกในระดบัสูง

1. ใหลดความละเอียดการแสดงผลสําหรับแอปพลิเคชั่นปจจุบันหรือ
ศกึษาจากเอกสารประกอบทีจั่ดสงมาพรอมกบัแอปพลิ
เคชนันัน้เพื่อดคูําแนะนําเกีย่วกบัวิธกีารปรับปรุงประสิทธิภาพดวย
การปรับคาพารามิเตอรในแอปพลิเคชั่น

2. เพิ่มหนวยความจํา

3. อัพเกรดโซลูชนัดานกราฟก

ไมทราบสาเหตุ เร่ิมการทํางานของคอมพิวเตอรใหม

เครือ่งปดเองโดยอตัโนมตัแิละไฟสถานะเปดเครื่องกะพรบิเปนสแีดง 2 ครัง้ทกุๆ วินาท ีจากนัน้เวน 2 วนิาท ีและมีสญัญาณเสยีง 2 ครัง้ (เสยีงเตอืนจะหยดุ
หลงัจากดงัตดิตอกนัเปนครั้งที ่5 แตไฟ LED จะกะพรบิตอไป)

สาเหตุ วธิแีกไข

ระบบปองกนัความรอนของโปรเซสเซอรถกูเปดใชงาน:

พดัลมอาจถูกปดกัน้หรือไมทํางาน

หรือ

ตวัระบายความรอน/พดัลมไมไดเชือ่มตอกบัโปรเซสเซอรอยางถกูตอง

1. ตรวจสอบวาชองระบายอากาศไมไดถกูปดกัน้และพัดลมระบายความ
รอนทํางาน

2. เปดฝาครอบ กดปุมเพาเวอร แลวดูวาพดัลมทีโ่ปรเซสเซอรหมุนหรือ
ไม หากพดัลมทีโ่ปรเซสเซอรไมหมุน ใหตรวจดูวา ไดเสียบสายเคเบิล
ของพัดลมเขากบัเฮดเดอรบนเมนบอรดเรียบรอยแลวใชหรือไม

3. หากตอพัดลมแลวแตพัดลมไมหมุน ใหเปล่ียนชิน้สวนตัวระบายความ
รอน/พดัลม

4. ตดิตอผูใหบริการหรือตัวแทนจําหนายทีไ่ดรับอนญุาต

ไมสามารถเปดเครื่องคอมพวิเตอร และไฟแสดงสถานะทีแ่ผงดานหนาของคอมพวิเตอรไมกะพรบิ

สาเหตุ วธิแีกไข

ไมสามารถเริ่มตนการทาํงานของระบบ กดปุมเพาเวอรคางไวไมถึง 4 วินาท ีหากไฟสถานะฮารดไดรฟเปล่ียนเปนสี
เขยีว ใหปฏิบัตดิังนี:้

1. ตรวจสอบสวิตชเลือกระดบัแรงดนัไฟฟาทีด่านหลังของแหลงจายไฟ
บางรุนวาอยูในตําแหนงของระดบัแรงดนัไฟฟาที่ถกูตอง การตัง้คา
แรงดันไฟฟาที่เหมาะสมขึ้นอยูกบัประเทศ/พืน้ทีท่ีคุ่ณอาศยัอยู

2. ถอดการดเอ็กซแพนชนัทลีะชิ้นจนกวาไฟ 5V_aux บนเมนบอรดจะ
สวาง

3. เปล่ียนเมนบอรด

หรือ

กดปุมเพาเวอรคางไวไมถึง 4 วินาท ีหากไฟสถานะฮารดไดรฟไมเปล่ียน
เปนสีเขียว ใหปฏิบัตดิังนี:้

1. ตรวจดูวาอุปกรณเสียบปล๊ักเขากบัเตารับไฟฟาอยางถูกตอง

2. เปดฝาครอบ แลวตรวจดวูาตัวควบคมุปุมเพาเวอรเชื่อมตอเขากบั
เมนบอรดอยางถกูตอง

3. ตรวจดวูาสายแหลงจายไฟทัง้ 2 สายเชื่อมตอเขากบัเมนบอรดอยาง
ถกูตอง

ตาราง 2-1  การแกปญหาทัว่ไป (ตอ)
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ไมสามารถเปดเครื่องคอมพวิเตอร และไฟแสดงสถานะทีแ่ผงดานหนาของคอมพวิเตอรไมกะพรบิ

สาเหตุ วธิแีกไข

4. ตรวจดูวาไฟ 5V_aux บนเมนบอรดสวางหรือไม ถาไฟสวาง ให
เปล่ียนตวัควบคุมปุมเพาเวอร

5. ถาไฟ 5V_aux บนเมนบอรดดบั ใหเปล่ียนแหลงจายไฟ

6. เปล่ียนเมนบอรด

ตาราง 2-1  การแกปญหาทั่วไป (ตอ)
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การแกไขปญหาเกีย่วกบัไฟ
ตารางตอไปน้ีแสดงสาเหตแุละการแกไขปญหาเก่ียวกับไฟท่ีพบบอย

ตาราง 2-2  การแกไขปญหาเกีย่วกบัไฟ

แหลงจายไฟไมทาํงานในบางครั้ง

สาเหตุ วธิแีกไข

สวิตชเลือกระดับแรงดันไฟฟาทีด่านหลังของโครงเครื่อง (บางรุน) ไมอยูใน
ตาํแหนงของระดบัแรงดนัไฟฟาท่ีถกูตอง (115V หรือ 230V)

เลือกระดับแรงดันไฟฟากระแสสลับทีถ่กูตองโดยใชสวิตชเลือก

แหลงจายไฟไมทาํงานเนือ่งจากมีขอขดัของภายใน ตดิตอผูใหบริการทีไ่ดรับอนุญาต เพื่อเปล่ียนแหลงจายไฟ

เครือ่งปดเองโดยอตัโนมตัแิละไฟสถานะเปดเครื่องกะพรบิเปนสแีดง 2 ครัง้ทกุๆ วินาท ีจากนัน้เวน 2 วนิาท ีและมีสญัญาณเสยีง 2 ครัง้ (เสยีงเตอืนจะหยดุ
หลงัจากดงัตดิตอกนัเปนครั้งที ่5 แตไฟ LED จะกะพรบิตอไป)

สาเหตุ วธิแีกไข

ระบบปองกนัความรอนของโปรเซสเซอรถกูเปดใชงาน:

พดัลมอาจถูกปดกัน้หรือไมทํางาน

หรือ

ตวัระบายความรอน/พดัลมไมไดเชือ่มตอกบัโปรเซสเซอรอยางถกูตอง

1. ตรวจสอบวาชองระบายอากาศไมไดถกูปดกัน้และพัดลมระบายความ
รอนทํางาน

2. เปดฝาครอบ กดปุมเพาเวอร แลวดูวาพดัลมทีโ่ปรเซสเซอรหมุนหรือ
ไม หากพดัลมทีโ่ปรเซสเซอรไมหมุน ใหตรวจดูวา ไดเสียบสายเคเบิล
ของพัดลมเขากบัเฮดเดอรบนเมนบอรดเรียบรอยแลวใชหรือไม

3. หากตอพัดลมแลวแตพัดลมไมหมุน ใหเปล่ียนชิน้สวนตัวระบายความ
รอน/พดัลม

4. ตดิตอผูใหบริการหรือตัวแทนจําหนายทีไ่ดรับอนญุาต

ไฟสถานะเปดเครื่องกะพรบิเปนสแีดง 4 ครั้งทกุๆ วนิาท ีจากนัน้เวน 2 วนิาท ีและคอมพวิเตอรสงสัญญาณเสยีง 4 ครัง้ (เสยีงเตอืนจะหยดุหลงัจากดงัตดิ
ตอกนัเปนครั้งที ่5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วธิแีกไข

แหลงจายไฟไมทํางาน (แหลงจายไฟโอเวอรโหลด) 1. ตรวจสอบสวิตชเลือกระดบัแรงดนัไฟฟาทีด่านหลังของแหลงจายไฟ
(ในคอมพวิเตอรบางรุน) วาอยูในตําแหนงของระดบัแรงดนัไฟฟาที่
ถกูตอง การตั้งคาแรงดันไฟฟาทีเ่หมาะสมขึน้อยูกับประเทศ/พืน้ที่ที่
คณุอาศัยอยู

2. เปดฝาครอบ แลวตรวจดวูาสายเคเบิลของแหลงจายไฟแบบ 4 หรือ
6 สาย เชื่อมตอเขากบัชองเสียบบนเมนบอรดแลว

3. ตรวจสอบวาอุปกรณเปนสาเหตุใหเกดิปญหานีห้รือไม โดยถอด
อุปกรณทัง้หมดทีเ่ชือ่มตออยู (เชน ฮารดไดรฟ ดิสเกต็ตไดรฟ
หรือไดรฟออปตคิัล และการดเอ็กซแพนชัน) เปดเคร่ืองคอมพิวเตอร
หากคอมพวิเตอรเขาสู POST ใหปดเคร่ือง แลวตออุปกรณกลับคืน
คร้ังละชิ้น และทําตามขั้นตอนดงักลาวซ้ําอีกคร้ังจนกวาเคร่ืองจะไม
ทาํงาน เปล่ียนอุปกรณที่เปนสาเหตุใหเคร่ืองไมทํางาน ตออุปกรณ
กลับคืนคร้ังละชิน้ เพือ่ใหแนใจวาอุปกรณทั้งหมดทํางานเปนปกติ

4. เปล่ียนแหลงจายไฟ

5. เปล่ียนเมนบอรด

อะแดปเตอรแหลงจายไฟภายนอกทีไ่มถูกตองกาํลังถกูใชงานอยุบน
USDT

อะแดปเตอรแหลงจายไฟ USDT ตองอยูที่ 135 วัตตและใชเทคโนโลยี
Smart ID กอนทีร่ะบบจะเริ่มทํางาน เปล่ียนอะแดปเตอรแหลงจายไฟดวย
อะแดปเตอรแหลงจายไฟ USDT ของ HP
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การแกไขปญหาเกีย่วกบัดสิเกต็ต
ตารางตอไปนี้แสดงสาเหตแุละการแกไขปญหาเก่ียวกับดิสเก็ตตที่พบบอย

หมายเหต:ุ คุณอาจตองตั้งคาคอมพิวเตอรใหมเม่ือคุณเพ่ิมหรือถอดฮารดแวร เชน ดิสเก็ตตไดรฟเพ่ิมเตมิ โปรดดูคําแนะนํา
ใน การแกไขปญหาในการติดตัง้ฮารดแวร ในหนา 32

ตาราง 2-3  การแกไขปญหาเกีย่วกบัดสิเกต็ต

ไฟของดสิเกต็ตไดรฟตดิตลอดเวลา

สาเหตุ วธิแีกไข

ดสิเก็ตตเกิดความเสียหาย ใน Microsoft Windows XP ใหคลิกขวาที่ Start คลิก Explore แลว
เลือกไดรฟ เลือก File > Properties > Tools ใต Error-checking
คลิก Check Now

ใน Microsoft Windows Vista ใหคลิกขวาที ่เริม่ คลิก สาํรวจ และ
คลิกขวาทีไ่ดรฟ เลือก คณุสมบตั ิและเลือกแท็บ เครือ่งมอื ใต การตรวจสอบ
ขอผดิพลาด คลิก ตรวจสอบเดีย๋วนี้

ใสแผนดสิเกต็ตไมถกูตอง ดงึแผนดิสเกต็ตออกและใสใหมอีกคร้ัง

ตอสายเคเบิลของไดรฟไมถกูตอง ตอสายเคเบิลของไดรฟใหม ตรวจสอบใหแนใจวาพินทัง้สี่บนสายไฟตอเขา
กบัดิสเกต็ตไดรฟอยางเหมาะสม

ไมพบไดรฟ

สาเหตุ วธิแีกไข

สายเคเบิลหลวม ตอสายเคเบิลขอมูลและสายไฟของดิสเกต็ตไดรฟอกีคร้ัง

ไมไดตดิตัง้ไดรฟที่ถอดเขาออกไดอยางถกูตอง ตดิตัง้ไดรฟใหมอีกคร้ัง

มกีารซอนอุปกรณในการตัง้คาคอมพวิเตอร รันยทูิลิตกีารตั้งคาคอมพวิเตอรและดใูหแนใจวาไดเลือก Device
Available สําหรับ Legacy Diskette ใน Security > Device
Security

ดสิเกต็ตไดรฟไมสามารถเขยีนลงแผนดสิเกต็ต

สาเหตุ วธิแีกไข

ไมไดฟอรแมตแผนดิสเกต็ต ฟอรแมตแผนดสิเกต็ต

1. เลือกไดรฟ (A) ใน Windows Explorer

2. คลิกขวาทีต่วัอักษรของไดรฟ และเลือก Format

3. เลือกตัวเลือกทีต่องการ และคลิก Start เพื่อเร่ิมฟอรแมตดิสเกต็ต

ดสิเก็ตตมีการปองกนัการเขียน ใชดิสเกต็ตแผนอื่น หรือยกเลิกการปองกนัการเขียน

มีการเขียนผดิไดรฟ ตรวจสอบชือ่ไดรฟในขอความระบุตําแหนง

พืน้ทีว่างในดสิเก็ตตไมเพยีงพอ 1. ใชแผนดิสเกต็ตอื่น

2. ลบไฟลทีไ่มตองการออกจากดสิเกต็ต
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ดสิเกต็ตไดรฟไมสามารถเขยีนลงแผนดสิเกต็ต

สาเหตุ วธิแีกไข

การเขียนดิสเกต็ตรุนเกาถกูยกเลิกการใชงานในยทูลิิตกีารตัง้คา
คอมพิวเตอร

เขาสูยทูลิิตกีารตัง้คาคอมพวิเตอร และเปดใช Legacy Diskette Write
ใน Storage > Storage Options

ดสิเกต็ตเกดิความเสียหาย เปลี่ยนดสิเกต็ต

ไมสามารถฟอรแมตดสิเกต็ต

สาเหตุ วธิแีกไข

การรายงานสื่อเก็บขอมูลไมถกูตอง เมื่อฟอรแมตดสิกใน MS-DOS คณุอาจตองระบคุวามจุของแผน เชน ใน
การฟอรแมตดสิเก็ตตขนาด 1.44 เมกะไบต ใหพมิพคําสั่งตอไปนีใ้น
พรอมตของ MS-DOS:

FORMAT A: /F:1440

ดสิกอาจมีการปองกนัการเขียน เปดตัวล็อคบนดิสเกต็ต

การเขียนดิสเกต็ตรุนเกาถกูยกเลิกการใชงานในยทูลิิตกีารตัง้คา
คอมพิวเตอร

เขาสูยทูลิิตกีารตัง้คาคอมพวิเตอร และเปดใช Legacy Diskette Write
ใน Storage > Storage Options

เกดิขอผดิพลาดในการใชงานดสิก

สาเหตุ วธิแีกไข

โครงสรางไดเรคทอร่ีไมถกูตอง หรือไฟลมีปญหา ใน Microsoft Windows XP ใหคลิกขวาที ่Start คลิก Explore แลว
เลือกไดรฟ เลือก File > Properties > Tools ใต Error-checking
คลิก Check Now

ใน Microsoft Windows Vista ใหคลิกขวาที ่เริม่ คลิก สาํรวจ และ
คลิกขวาทีไ่ดรฟ เลือก คณุสมบตั ิและเลือกแท็บ เครือ่งมอื ใต การตรวจสอบ
ขอผดิพลาด คลิก ตรวจสอบเดีย๋วนี้

ดสิเกต็ตไดรฟไมสามารถอานแผนดสิเกต็ต

สาเหตุ วธิแีกไข

คณุใชดิสเกต็ตผดิประเภทสําหรับไดรฟ ตรวจสอบประเภทของไดรฟทีคุ่ณกาํลังใช และใชดสิเกต็ตที่ถกูตอง

คณุกําลังอานขอมูลผิดไดรฟ ตรวจสอบชือ่ไดรฟในขอความระบุตาํแหนง

ดสิเกต็ตเกดิความเสียหาย เปลี่ยนดสิเกต็ต

มขีอความ “Invalid system disk” ปรากฏขึน้

สาเหตุ วธิแีกไข

มกีารใสดิสเกต็ตที่ไมมีไฟลระบบทีจํ่าเปนตอการเปดคอมพวิเตอรลง
ในไดรฟ

เมื่อไดรฟหยุดทํางาน นําดิสเกต็ตออกและกด Spacebar คอมพิวเตอรจะ
เร่ิมตนระบบตอไป

เกดิขอผดิพลาดในดสิเก็ตต รีสตารทคอมพวิเตอรของคณุ โดยกดปุมเพาเวอร

ตาราง 2-3  การแกไขปญหาเกีย่วกบัดสิเกต็ต (ตอ)
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ไมสามารถบตูจากแผนดสิเกต็ต

สาเหตุ วธิแีกไข

แผนดสิเกต็ตเปนแบบที่บูตไมได เปล่ียนเปนแผนดสิเกต็ตทีบู่ตได

มกีารยกเลิกการบูตจากแผนดิสเก็ตตในยทูลิิตกีารตัง้คาคอมพวิเตอร 1. รันยทูิลิตกีารตั้งคาคอมพวิเตอร และเปดใชการบูตดวยดิสเกต็ตใน
Storage > Boot Order

2. รันยทูิลิตกีารตั้งคาคอมพวิเตอร และเปดใชการบูตดวยดิสเกต็ตใน
Storage > Storage Options > Removable Media Boot

หมายเหต:ุ ควรปฏิบัติขัน้ตอนทั้งสอง เพราะฟงกชนั Removable
Media Boot ในยทูลิิตีการตัง้คาคอมพิวเตอรจะแทนทีค่ําสั่งเปดใช Boot
Order

Network Server Mode ถกูเปดใชงานในยทูลิิตกีารตัง้คาคอมพวิเตอร รันยทูิลิตกีารตั้งคาคอมพวิเตอร แลวยกเลิกการใชงาน Network Server
Mode ใน Security > Password Options

ตาราง 2-3  การแกไขปญหาเกีย่วกบัดสิเกต็ต (ตอ)
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การแกไขปญหาเกีย่วกบัฮารดไดรฟ
ตาราง 2-4  การแกไขปญหาเกีย่วกบัฮารดไดรฟ

เกดิขอผดิพลาดของฮารดไดรฟ

สาเหตุ วธิแีกไข

ฮารดดสิกมีเซ็คเตอรทีเ่สียหายหรือใชงานไมได 1. ใน Microsoft Windows XP ใหคลิกขวาที ่Start คลิก Explore
แลวเลือกไดรฟ เลือก File > Properties > Tools ใต Error-
checking คลิก Check Now

ใน Microsoft Windows Vista ใหคลิกขวาที ่เริ่ม คลิก สํารวจ และ
คลิกขวาทีไ่ดรฟ เลือก คณุสมบตั ิและเลือกแทบ็ เครื่องมอื ใต การ
ตรวจสอบขอผดิพลาด คลิก ตรวจสอบเดีย๋วนี้

2. ใชยทูิลิตเีพื่อคนหาตาํแหนงและบล็อคการใชสวนทีเ่สีย หากจําเปน
ใหฟอรแมตฮารดดสิกใหม

เกดิขอผดิพลาดในการใชงานดสิก

สาเหตุ วธิแีกไข

โครงสรางไดเรคทอรีไมถกูตอง หรือไฟลมีปญหา ใน Microsoft Windows XP ใหคลิกขวาที ่Start คลิก Explore แลว
เลือกไดรฟ เลือก File > Properties > Tools ใต Error-checking
คลิก Check Now

ใน Microsoft Windows Vista ใหคลิกขวาที ่เริม่ คลิก สาํรวจ และ
คลิกขวาทีไ่ดรฟ เลือก คณุสมบตั ิและเลือกแท็บ เครือ่งมอื ใต การตรวจสอบ
ขอผดิพลาด คลิก ตรวจสอบเดีย๋วนี้

ไมพบไดรฟ (ทีร่ะบุ)

สาเหตุ วธิแีกไข

สายเคเบิลอาจหลวม ตรวจสอบการตอสายเคเบิล

ระบบอาจไมรับทราบถงึไดรฟทีต่ดิตัง้ขึน้ใหมไดโดยอัตโนมัติ โปรดดูคาํแนะนาํในการตัง้คาใหมในหัวขอ การแกไขปญหาในการตดิตั้ง
ฮารดแวร ในหนา 32 หากระบบยงัไมรับรูถงึอุปกรณใหม ใหตรวจสอบ
วามีอุปกรณนัน้แสดงอยูภายในยทูิลิตกีารตัง้คาคอมพวิเตอรหรือไม หากมี
อยู สาเหตุของปญหาอาจอยูทีไ่ดรเวอร แตหากไมมีอุปกรณดังกลาวอยู
ปญหานีอ้าจเกดิจากฮารดแวร

หากไดรฟนัน้เปนไดรฟที่ตดิตัง้ใหม ใหรันยทูิลิตกีารตั้งคาคอมพวิเตอร
และลองเพิ่มระยะเวลาการรอในกระบวนการ POST ที่ Advanced >
Power-On

อปุกรณติดตั้งลงในพอรต SATA ทีถ่กูซอนไวในยทูิลิตีการตั้งคา
คอมพิวเตอร

รันยทูลิิตกีารตัง้คาคอมพิวเตอร และโปรดตรวจสอบใหแนใจวาเลือก
Device Available สําหรับพอรต SATA ของอุปกรณใน Security >
Device Security ไวแลว

ไดรฟตอบสนองชาหลังจากการเริ่มตนระบบ รันยทูลิิตกีารตัง้คาคอมพิวเตอร และเพิ่มเวลารอของกระบวนการ POST
ใน Advanced > Power-On Options
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มขีอความ Nonsystem disk/NTLDR missing

สาเหตุ วธิแีกไข

ระบบพยายามเริ่มตนการทํางานจากแผนดสิเก็ตตทีบู่ตไมได นําแผนดิสเกต็ตนัน้ออกจากไดรฟ

ระบบพยายามเร่ิมตนการทํางานจากฮารดไดรฟ แตฮารดไดรฟอาจมีความ
เสียหาย

1. ใสแผนดสิเกต็ตทีบู่ตไดในดสิเกต็ตไดรฟและเร่ิมระบบใหม

2. ตรวจสอบฟอรแมตของฮารดไดรฟโดยใช fdisk: หากเปนฟอรแมต
NTFS ใหใชเคร่ืองอานของผูผลิตอื่นเพือ่ประเมินไดรฟ หากเปน
ฟอรแมต FAT32 จะไมสามารถเขาถงึฮารดไดรฟดงักลาวได

ไฟลระบบขาดหายไปหรือไมไดตดิตัง้อยางเหมาะสม 1. ใสแผนดสิเกต็ตทีบู่ตไดในดสิเกต็ตไดรฟและเร่ิมระบบใหม

2. ตรวจสอบฟอรแมตของฮารดไดรฟ โดยใช Fdisk: หากเปน
ฟอรแมต NFTFS ใหใชเคร่ืองอานของผูผลิตอื่นเพื่อประเมินไดรฟ
หากเปนฟอรแมต FAT32 จะไมสามารถเขาถึงฮารดไดรฟดงักลาว
ได

3. ตดิตัง้ไฟลระบบสําหรับระบบปฏิบัตกิารทีเ่หมาะสม

มกีารตัดการบูตจากแผนฮารดไดรฟในยทูลิิตีการตั้งคาคอมพวิเตอร รันยทูิลิตกีารตัง้คาคอมพวิเตอรและเลือกรายการฮารดไดรฟในรายการ
Storage > Boot Order

ไมไดเชื่อมตอฮารดไดรฟทีใ่ชบูตไวเปนลําดบัแรกในระบบทีม่ี
ฮารดไดรฟหลายตวั

หากพยายามจะบูตจากฮารดไดรฟ โปรดแนใจวาเชือ่มตอฮารดไดรฟกับ
ชองเสียบของเมนบอรด ทีม่ีเคร่ืองหมาย P60 SATA 0

คอนโทรลเลอรของฮารดไดรฟทีใ่ชบูตไมอยูในรายการลําดับการบูต รันยทูิลิตกีารตั้งคาคอมพวิเตอร แลวเลือก Storage > Boot Order และ
ตรวจสอบใหแนใจวาคอนโทรลเลอรของฮารดไดรฟทีใ่ชบูตปรากฏอยูใน
รายการ Hard Drive

คอมพวิเตอรจะไมบตูจากฮารดไดรฟ

สาเหตุ วธิแีกไข

อปุกรณติดตั้งลงในพอรต SATA ทีถ่กูซอนไวในยทูิลิตีการตัง้คา
คอมพิวเตอร

รันยทูิลิตกีารตั้งคาคอมพวิเตอร และโปรดตรวจสอบใหแนใจวาเลือก
Device Available สําหรับพอรต SATA ของอุปกรณใน Security >
Device Security ไวแลว

ลําดับการบูตไมถกูตอง รันยทูิลิตกีารตั้งคาคอมพวิเตอร แลวเปล่ียนลําดับการบูตใน Storage >
Boot Order

“Emulation Type” ของฮารดไดรฟถูกตั้งเปน „None“ รันยทูิลิตกีารตั้งคาคอมพวิเตอร และเปล่ียน "Emulation Type" เปน
"Hard Disk" ในรายละเอียดของอุปกรณใต Storage > Device
Configuration

ฮารดไดรฟเกดิความเสียหาย สงัเกตวาไฟสถานะเปดเคร่ืองทีแ่ผงดานหนากะพริบเปนสีแดง และมี
สัญญาณเสียงดังขึน้ โปรดดูภาคผนวก A ขอความแสดงขอผิดพลาดของ
POST ในหนา 48 เพื่อระบุสาเหตทุีเ่ปนไปไดสําหรับไฟกะพริบสีแดง
และรหสัเสียง

โปรดดขูอกําหนดและเงื่อนไขสําหรับการรับประกนัแบบจํากดัทัว่โลก

คอมพวิเตอรเหมอืนจะคาง

สาเหตุ วธิแีกไข

โปรแกรมที่ใชอยูหยุดตอบสนองตอคําส่ังตางๆ ปดคอมพิวเตอรตามขั้นตอนปกตขิอง Windows หากไมสามารถปดเคร่ือง
ได กดปุมเพาเวอรคางไวเปนเวลาสี่วินาทหีรือเกนิกวานัน้พ่ือปดคอม
พวิเตอร ในการรีสตารทคอมพิวเตอร กดปุมเพาเวอรอีกคร้ัง

ตาราง 2-4  การแกไขปญหาเกีย่วกบัฮารดไดรฟ (ตอ)
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ฮารดไดรฟแบบทีถ่อดออกไดไมไดจายกระแสไฟฟาไปทีโ่ครงเครือ่งของฮารดไดรฟ

สาเหตุ วธิแีกไข

ไมไดปรับตวัล็อคของโครงเครื่องมาอยูที่ตาํแหนง “On” ใสกุญแจ กอนหมุนตัวล็อคตามเขม็นาฬกิา 90 องศา ไฟ LED สีเขยีวทาง
ดานหนาของโครงเครื่องควรติด

ไมไดเชื่อมตอสายไฟจากแหลงจายไฟของคอมพวิเตอรไปทีก่รอบโครง
เคร่ืองไวอยางเหมาะสม

ตรวจสอบแหลงจายไฟเพือ่ใหแนใจวา เชื่อมตอเขากบัดานหลังของกรอบ
โครงเครื่องไดอยางเหมาะสมแลว

คอมพวิเตอรไมรับรูถงึฮารดไดรฟแบบทีถ่อดออกได

สาเหตุ วธิแีกไข

ไมไดใสโครงเหล็กของฮารดไดรฟแบบทีถ่อดออกไดลงในกรอบโครง
เคร่ืองจนสุด หรือฮารดไดรฟไมไดอยูในโครงเหล็กอยางเหมาะสม

ดนัโครงเหล็กเขาไปในกรอบโครงเครื่อง เพือ่ใหชองเสียบที่ดานหลังของ
โครงอยูในตาํแหนงท่ีเหมาะสม หากทาํแลวยังไมสามารถแกไขปญหาได
ใหปดคอมพวิเตอร นําโครงเหล็กออก และตรวจสอบวา ชองเสียบทีอ่ยูบน
ฮารดไดรฟนั้นอยูในตําแหนงทีเ่หมาะสมบนโครงเหล็กแลวหรือไม

มเีสยีงบีป๊ดงัออกมาจากโครงเครือ่งของฮารดไดรฟแบบทีถ่อดออกไดและไฟ LED สเีขยีวกะพรบิ

สาเหตุ วธิแีกไข

ไฟเตือนพดัลมเสียทีอ่ยูบนโครงเครื่องของฮารดไดรฟแบบทีถ่อดออกได
กาํลังทํางาน

ปดคอมพวิเตอรและติดตอ HP เพือ่ขอเปล่ียนโครงเคร่ือง

ตาราง 2-4  การแกไขปญหาเกีย่วกบัฮารดไดรฟ (ตอ)
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การแกไขปญหาตวัอานการดมเีดยี
ตาราง 2-5  การแกไขปญหาตวัอานการดมเีดยี

การดมเีดยีจะไมทาํงานในกลองดจิติอลหลงัจากฟอรแมตใน Microsoft Windows XP หรอื Microsoft Windows Vista

สาเหตุ วธิแีกไข

ตามคาดฟีอลตนัน้ Windows XP และ Windows Vista จะฟอรแมต
การดมีเดียใดๆ ที่มีความจุเกนิ 32MB ดวยรูปแบบ FAT32 กลองดจิิตอล
สวนใหญใชรูปแบบ FAT (FAT16 และ FAT12) และไมสามารถทํางาน
กบัการดที่ถกูฟอรแมตแบบ FAT32

ใหฟอรแมตการดมีเดียทีอ่ยูในกลองดิจิตอล หรือเลือกระบบไฟล FAT เพื่อ
ฟอรแมตการดมีเดยีทีอ่ยูในคอมพิวเตอรดวย Windows XP หรือ
Windows Vista

เกดิขอผดิพลาดปองกนัการเขยีนหรอืขอผดิพลาดการลอ็คในขณะทีพ่ยายามเขยีนบนการดมเีดยี

สาเหตุ วธิแีกไข

การดมีเดียถกูล็อค การล็อคการดมีเดียคอืคุณสมบัตดิานความปลอดภัยที่
ปองกนัการเขยีนและการลบออกจากการด SD/Memory Stick/PRO

หากใชการด SD ควรดูใหแนใจวา แทบ็ล็อคทีด่านขวาของการด SD ไมได
อยูในตําแหนงล็อค หากใชการด Memory Stick/PRO ควรดใูหแนใจวา
แท็บล็อคทีด่านลางของการด Memory Stick/PRO ไมไดอยูใน
ตําแหนงล็อค

ไมสามารถเขยีนลงในการดมเีดยีได

สาเหตุ วธิแีกไข

การดมีเดยีเปนการดหนวยความจํา (ROM) แบบอานอยางเดียว ตรวจสอบจากเอกสารประกอบของผูผลิตทีม่าพรอมกบัการดเพ่ือดวูาการด
นีเ้ปนแบบเขียนลงไปไดหรือไม โปรดดูทีส่วนกอนหนานีห้ากตองการ
รายการการดทีใ่ชรวมกนัได

การดมีเดียถกูล็อค การล็อคการดมีเดียคอืคุณสมบัตดิานความปลอดภัยที่
ปองกนัการเขยีนและการลบออกจากการด SD/Memory Stick/PRO

หากใชการด SD ควรดูใหแนใจวา แทบ็ล็อคทีด่านขวาของการด SD ไมได
อยูในตําแหนงล็อค หากใชการด Memory Stick/PRO ควรดใูหแนใจวา
แท็บล็อคทีด่านลางของการด Memory Stick/PRO ไมไดอยูใน
ตําแหนงล็อค

ไมสามารถเขาถงึขอมลูทีอ่ยูบนการดมเีดยีหลงัจากใสการดลงในสล็อต

สาเหตุ วธิแีกไข

ใสการดมีเดยีไมเหมาะสม ใสลงในสล็อตทีไ่มถูกตอง หรือระบบไมรองรับ
การดมีเดยีดงักลาว

ดใูหแนใจวา ไดใสการดไดอยางเหมาะสม โดยหนาสัมผัสสีทองอยูในดานที่
ถกูตอง ไฟสีเขียวจะสวางขึ้นหากใสการดไดอยางถกูตอง

ไมทราบวธิถีอดการดทีถ่กูตอง

สาเหตุ วธิแีกไข

ใชซอฟตแวรของคอมพิวเตอรเพ่ือดดีการดออกอยางปลอดภัย เปด คอมพวิเตอรของฉนั (Windows XP) หรือ คอมพวิเตอร (Windows
Vista) คลิกขวาทีไ่อคอนไดรฟทีเ่กี่ยวของ และเลือก ออก กอนดึงการดออก
จากสล็อต

หมายเหต:ุ หามดึงการดในขณะทีไ่ฟสีเขียวกะพริบ
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หลงัจากตดิตัง้ตวัอานการดมเีดยีและบตูไปที ่Windows แลว คอมพวิเตอรไมรบัรูถงึตวัอานและการดทีใ่สลงไป

สาเหตุ วธิแีกไข

ระบบปฏิบตัิการตองการเวลาเพื่อรับรูถงึอุปกรณนัน้ หากเพิ่งติดตั้งตัวอาน
ลงในคอมพิวเตอร และคุณเปดคอมพิวเตอรเปนคร้ังแรก

รอประมาณ 1-2 วินาทีเพ่ือใหระบบปฏิบัติการรับรูถงึตัวอานและพอรตทีน่ํา
มาใชได กอนรับรูวา คณุใสมีเดยีใดลงในตัวอาน

หลงัจากใสการดมเีดยีลงในตวัอาน คอมพวิเตอรพยายามบตูจากการดมเีดยี

สาเหตุ วธิแีกไข

การดมีเดียทีใ่สในคอมพวิเตอรสามารถใชบูตได หากคุณไมตองการบูตจากการดมีเดีย ใหถอดการดออกในระหวางที่บูต
หรือไมเลือกตวัเลือกเพือ่บูตจากการดมีเดยีทีใ่สไวในระหวางขัน้ตอนการ
บูต

ตาราง 2-5  การแกไขปญหาตวัอานการดมเีดยี (ตอ)
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การแกไขปญหาเกีย่วกบัการแสดงผล
หากคณุพบปญหาเก่ียวกับการแสดงผลบนจอภาพ โปรดอานเอกสารที่มาพรอมกับหนาจอหรือดูสาเหตุและการแกไขปญหาที่
พบบอยในตารางตอไปน้ี

ตาราง 2-6  การแกไขปญหาเกีย่วกบัการแสดงผล

หนาจอวางเปลา (ไมมกีารแสดงผล)

สาเหตุ วธิแีกไข

ไมไดเปดหนาจอ ไฟหนาจอไมตดิ เปดหนาจอ และดูวาไฟหนาจอติด

จอภาพไมดี ลองเปล่ียนไปใชจอภาพอื่น

ตอสายเคเบิลไมถูกตอง ตรวจสอบการตอสายเคเบิลจากจอภาพไปยงัเคร่ืองคอมพวิเตอร และสาย
ไฟทีเ่สียบเขากบัเตารับไฟฟา

คณุอาจติดตัง้ยทูลิิตีปดหนาจอหรือมีการใชคณุสมบัตปิระหยดัพลังงาน กดปุมใดๆ ก็ไดบนแปนพิมพหรือคลิกปุมเมาส และปอนรหสัผานหากมีการ
กําหนดไว

ROM ของระบบเสียหาย ระบบกาํลังรันในโหมดกูคืนฉุกเฉินบล็อคการบูต
(ซึ่งระบุจากสัญญาณเสียงแปดครั้ง)

แฟลช ROM ของระบบอีกคร้ัง ดวยอิมเมจลาสุดของ BIOS โปรดดูราย
ละเอียดเพิม่เติมในหวัขอ โหมดกูคืนฉุกเฉินบล็อคการบูต” ใน คูมือการ
จัดการเดสกทอป

คณุใชจอภาพทีม่ีการซิงโครไนซคงที ่และไมสามารถซิงโครไนซทีค่วาม
ละเอียดทีเ่ลือกไว

ตรวจสอบวาจอภาพสามารถรองรับอัตราการกวาดภาพทีเ่หมือนกับอัตรา
ความละเอียดทีเ่ลือกไว

คอมพิวเตอรอยูในโหมด สแตนดบาย กดปุมเพาเวอรเพ่ือออกจากโหมด สแตนดบาย

ขอควรระวงั: เมื่อพยายามจะทํางานตอจากโหมด สแตนดบาย อยากดปุม
เพาเวอรนานเกนิสี่วินาท ีมิฉะนัน้ คอมพิวเตอรจะปดลง และคณุจะสูญเสีย
ขอมูลทีย่งัไมไดจัดเกบ็

สายเคเบิลของจอภาพเสียบกบัพอรตทีไ่มถกูตอง หากระบบคอมพวิเตอรมีทั้งชองเสียบสําหรับกราฟกภายใน และชองเสียบ
การดแสดงผลเพิม่เติม ใหเสียบสายเคเบิลของจอภาพเขากบัชองเสียบการด
แสดงผลทีด่านหลังของเครื่องคอมพวิเตอร

การตั้งคาจอภาพในเครื่องคอมพิวเตอรไมตรงกบัจอภาพที่ใช 1. ในแผงควบคุมของ Windows XP ใหดับเบิลคลิกทีไ่อคอน การ
แสดงผล แลวเลือกแท็บ การตัง้คา

ในแผงควบคุมของ Windows Vista ใต ลกัษณะทีป่รากฏและการ
ตัง้คาสวนบคุคล ใหเลือก ปรบัความละเอยีดของหนาจอ

2. ปรับแถบเลื่อนเพื่อตัง้คาความละเอียดใหม

จอภาพถูกกําหนดคาใหใชอินพตุทีไ่มไดใชงานอยู ใชสวนควบคุมเมนบูนหนาจอของจอภาพเพื่อเลือกอินพุตที่ถกูควบคุมโดย
ระบบ โปรดดูเอกสารคูมือการใชงานจอภาพสําหรับขอมูลเพิ่มเตมิเกีย่วกบั
ตวัควบคุมและการตั้งคาบนหนาจอ

ไมสามารถเปดใชกราฟกภายในหลงัจากตดิตัง้การดแสดงผล PCI-Express

สาเหตุ วธิแีกไข

บนระบบที่ตดิตัง้กราฟกภายใน คณุจะไมสามารถเปดใชกราฟกภายในได
หลังจากติดตัง้การดแสดงผล PCI Express x16

กราฟกภายในสามารถเปดใชใน Computer Setup หากไดติดตัง้การด
แสดงผล PCI หรือ PCI Express x1 แลว แตจะไมสามารถใชงานไดหาก
มกีารดแสดงผลในสล็อต PCI Express x16

THWW การแกไขปญหาเก่ียวกับการแสดงผล 23



หนาจอวางเปลา ไฟสถานะเปดเครือ่งกะพรบิเปนสแีดง 5 ครั้งทกุๆ วนิาท ีจากนัน้เวน 2 วนิาท ีและคอมพวิเตอรสงสญัญาณเสยีง 5 ครัง้ (เสยีงเตอืนจะหยดุ
หลงัจากดงัตดิตอกนัเปนครั้งที ่5 แตไฟ LED จะกะพรบิตอไป)

สาเหตุ วธิแีกไข

หนวยความจําการแสดงผลเกดิขอผดิพลาด 1. ใส DIMM ใหมอีกคร้ัง เปดเคร่ืองคอมพวิเตอร

2. เปล่ียน DIMM ทลีะชิน้ เพื่อแยกโมดลูท่ีมีขอผิดพลาดออก

3. ใชหนวยความจําของ HP แทนหนวยความจําของผูผลิตรายอื่น

4. เปล่ียนเมนบอรด

หนาจอวางเปลา ไฟสถานะเปดเครือ่งกะพรบิเปนสแีดง 6 ครั้งทกุๆ วนิาท ีจากนัน้เวน 2 วนิาท ีและคอมพวิเตอรสงสญัญาณเสยีง 6 ครัง้ (เสยีงเตอืนจะหยดุ
หลงัจากดงัตดิตอกนัเปนครั้งที ่5 แตไฟ LED จะกะพรบิตอไป)

สาเหตุ วธิแีกไข

การแสดงผลมขีอผิดพลาด สําหรับระบบทีใ่ชการดแสดงผล:

1. ตดิตัง้การดแสดงผลใหม เปดเคร่ืองคอมพวิเตอร

2. เปล่ียนการดแสดงผล

3. เปล่ียนเมนบอรด

สําหรับระบบทีใ่ชกราฟกภายใน ใหเปล่ียนเมนบอรด

หนาจอวางเปลา ไฟสถานะเปดเครือ่งกะพรบิเปนสแีดง 7 ครัง้ทกุๆ วินาท ีจากนัน้เวน 2 วนิาท ีและคอมพวิเตอรสงสญัญาณเสยีง 7 ครัง้ เสยีงเตอืนจะหยดุ
หลงัจากดงัตดิตอกนัเปนครั้งที ่5 แตไฟ LED จะกะพรบิตอไป)

สาเหตุ วธิแีกไข

เมนบอรดขัดของ (ROM ตรวจพบการขัดของกอนการแสดงผล). เปล่ียนเมนบอรด

จอภาพไมทาํงานตามปกตเิมือ่ใชคณุสมบตัปิระหยดัพลงังาน

สาเหตุ วธิแีกไข

มกีารใชคณุสมบัตปิระหยดัพลังงานกบัจอภาพทีไ่มสามารถใชคณุสมบัตดิัง
กลาวได

ยกเลิกการใชงานคณุสมบัตปิระหยดัพลังงาน

ตวัอกัษรไมชดัเจน

สาเหตุ วธิแีกไข

มกีารปรับความสวางและความเขมของจอภาพอยางไมถกูตอง ปรับปุมควบคมุความสวางและความเขมของจอภาพ

ตอสายเคเบิลไมถูกตอง ตรวจสอบวาสายของจอภาพตอเขากบัการดแสดงผลอยางถกูตอง

ตาราง 2-6  การแกไขปญหาเกีย่วกบัการแสดงผล (ตอ)
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ภาพมวัและไมสามารถกาํหนดความละเอยีดทีต่องการ

สาเหตุ วธิแีกไข

หากมีการอัพเกรดคอนโทรลเลอรการแสดงผล คุณจะตอง
โหลดไดรเวอรการแสดงผลที่ถกูตอง

ตดิตัง้ไดรเวอรการแสดงผลจากดสิเกต็ตทีม่าพรอมกบัชดุอัพเกรด

จอภาพไมสามารถแสดงความละเอยีดตามทีต่องการได เปล่ียนความละเอียดทีต่ั้งคาไว

การดแสดงผลไมดี เปล่ียนการดแสดงผล

ภาพลม ไมเรียบ เปนรอยหยกั หรือกะพริบ

สาเหตุ วธิแีกไข

การเชื่อมตอจอภาพไมสมบูรณหรืออาจมีการตัง้คาจอภาพทีไ่มถกูตอง 1. ตรวจสอบสายเคเบิลของจอภาพวาตอกบัคอมพวิเตอรอยางแนนหนา

2. ในระบบสองจอภาพหรือหากมีจอภาพอื่นอยูใกลๆ โปรดตรวจสอบวา
ทัง้สองจอภาพไมรบกวนการทํางานซึ่งกันและกัน โดยยายจอภาพทัง้
สองออกหางจากกนั

3. จอภาพอยูใกลหลอดไฟหรือพดัลมมากเกนิไป

จําเปนตองลางสนามแมเหล็กใหกบัจอภาพ ลางสนามแมเหล็กใหกบัจอภาพ โปรดดูคาํแนะนาํในเอกสารทีม่าพรอมกบั
จอภาพ

ภาพไมอยูตรงกลาง:

สาเหตุ วธิแีกไข

อาจจําเปนตองปรับตําแหนง กดปุม Menu ของจอภาพเพือ่เขาสูเมนู OSD เลือก ImageControl/
Horizontal Position หรือ Vertical Position เพื่อปรับตําแหนงตาม
แนวนอนหรือแนวตัง้ของภาพ

ขอความ “No Connection, Check Signal Cable” แสดงขึน้ทีห่นาจอ

สาเหตุ วธิแีกไข

สายเคเบิลวิดโีอของจอภาพถกูตัดการเชือ่มตอ เชื่อมตอสายเคเบิลวิดีโอระหวางจอภาพและคอมพวิเตอร

ขอควรระวงั: ดูใหแนใจวาปดไฟเคร่ืองแลวเมื่อเชือ่มตอสายเคเบลิวิดีโอ

ขอความ “Out of Range” แสดงขึน้ทีห่นาจอ

สาเหตุ วธิแีกไข

ความละเอียดวิดโีอและอัตรารีเฟรชตั้งไวสูงกวาทีจ่อภาพรองรับ เร่ิมตนคอมพิวเตอรใหมและเขาสู Safe Mode เปล่ียนการตัง้คาใหเปนคา
ทีร่องรับ จากนัน้เร่ิมตนคอมพวิเตอรใหมเพือ่ใหการตั้งคาใหมมีผล

ตาราง 2-6  การแกไขปญหาเกีย่วกบัการแสดงผล (ตอ)
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มเีสยีงสัน่รวัดงัมาจากขางในของจอภาพ CRT ในขณะเปดเครื่อง

สาเหตุ วธิแีกไข

ขดลวดลางสนามแมเหล็กในจอภาพกําลังทํางาน ไมมี ตามปกติแลว ขดลวดลางสนามแมเหล็กจะทํางานเมือ่คุณเปดจอภาพ

มเีสยีงคลกิดงัมาจากขางในของจอภาพ CRT

สาเหตุ วธิแีกไข

รีเลยอิเล็กทรอนกิสในจอภาพกําลังทํางาน ไมมี ตามปกติแลว จอภาพบางรุนจะมีเสียงดงัคลิกเมื่อคุณเปดและปดเคร่ือง
เมื่อเขาสูและออกจากโหมดสแตนดบาย และเมื่อมีการเปลี่ยนคาความ
ละเอียด

มเีสยีงแหลมดงัมาจากขางในของจอภาพแบบเรยีบ

สาเหตุ วธิแีกไข

ความสวางและหรือความเขมสูงเกินไป ลดความสวางและหรือความเขม

ภาพไมคมชดั ภาพเปรอะ ภาพซอน หรือมเีงา มเีสนวิง่ในแนวนอน มแีถบจางๆ ในแนวตัง้ หรอืไมสามารถกาํหนดจดุศนูยกลางของภาพบนหนาจอ (เฉพาะ
จอภาพแบบเรยีบทีใ่ชการเชือ่มตอสญัญาณอนิพตุ VGA แบบอะนาลอ็ก)

สาเหตุ วธิแีกไข

วงจรการแปลงสัญญาณดิจิตอลภายในจอภาพแบบเรียบอาจไมสามารถตี
ความสัญญาณซิงโครไนซทีม่าจากการดแสดงผล

1. เลือกตัวเลือก Auto-Adjustment ในเมนกูารแสดงผลทีป่รากฏบน
หนาจอ

2. ทาํการซิงโครไนซฟงกชัน Clock และ Clock Phase ที่แสดงบน
หนาจอ คุณสามารถดาวนโหลด SoftPaq สําหรับการซิงโครไนซ
โดยไปยงัเว็บไซตดานลางนี้ แลวเลือกจอภาพทีเ่หมาะสม และ
ดาวนโหลด SP32347 หรือ SP32202: http://www.hp.com/
support

การดแสดงผลไมดีหรือไมไดรับการตดิตัง้อยางเหมาะสม 1. ตดิตัง้การดแสดงผลใหม

2. เปล่ียนการดแสดงผล

สัญลกัษณบางตวัทีพ่มิพไมตรงกบัทีป่รากฏบนหนาจอ

สาเหตุ วธิแีกไข

แบบอักษรทีค่ณุใชไมสนบัสนนุสัญลักษณนัน้ๆ ใช Character Map เพือ่คนหาและเลือกสัญลักษณทีคุ่ณตองการ คลิก
Start > All Programs > Accessories > System Tools >
Character Map คุณสามารถคัดลอกสัญลักษณทีต่องการจาก
Character Map ไปใสไวในเอกสาร

ตาราง 2-6  การแกไขปญหาเกีย่วกบัการแสดงผล (ตอ)
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การแกไขปญหาเกีย่วกบัระบบเสยีง
หากคอมพิวเตอรของคุณสามารถใชงานเก่ียวกับเสียงได และคณุพบปญหาเก่ียวกับระบบเสียง โปรดดูสาเหตุและการแกไข
ปญหาในตารางตอไปน้ี

ตาราง 2-7  การแกไขปญหาเกีย่วกบัระบบเสียง

เสยีงขาดๆ หายๆ

สาเหตุ วธิแีกไข

โปรเซสเซอรกาํลังถกูใชในการประมวลผลโปรแกรมอืน่ทีเ่ปดอยู ปดโปรแกรมทีต่องอาศัยการประมวลผลอยางมาก

ความลาชาของเสียง พบไดทั่วไปในโปรแกรมเลนสื่อ ใน Windows XP เทานัน้:

1. ใน Control Panel ใหเลือก Sounds and Audio Devices

2. บนแทบ็ Audio ใหเลือกอุปกรณจากรายการ Sound Playback

3. คลิกปุม Advanced แลวเลือกแทบ็ Performance

4. ปรับแถบเลื่อน Hardware acceleration ไปที ่None และปรับ
แถบเลื่อน Sample rate conversion quality ไปที ่Good จาก
นัน้ใหลองทดสอบเสียงอีกคร้ัง

5. ปรับแถบเลื่อน Hardware acceleration ไปที ่Full และปรับแถบ
เล่ือน Sample rate conversion quality ไปที ่Best จากนัน้ให
ลองทดสอบเสียงอีกคร้ัง

ไมมเีสยีงออกจากลาํโพงหรอืหฟูง

สาเหตุ วธิแีกไข

มกีารลดระดับเสียงหรือปดเสียงตวัควบคุมระดบัเสียงดวยซอฟตแวร ดบัเบิลคลิกทีไ่อคอนรูป ลาํโพง บนทาสกบาร จากนัน้ตรวจดวูาตัวเลือก
Mute ไมไดถกูเลือก และปรับระดับเสียงโดยเล่ือนแถบปรับระดับเสียง

เสียงถกูซอนอยูในยทูิลิตีการตั้งคาคอมพวิเตอร เปดใชงานเสียงในยทูลิิตีการตัง้คาคอมพวิเตอร: Security >
Device Security > System Audio.

ไมไดเปดลําโพง เปดลําโพง

อาจตออุปกรณเสียงเขากบัแจ็คผดิอัน ดใูหแนใจวา ไดตออุปกรณเขากบัแจ็คทีถ่กูตองทีค่อมพิวเตอร ลําโพงควร
จะเสียบลงทีด่านหลังของชองเสียบสัญญาณเสียงออกและหฟูงควรเสียบที่
ดานหนาของชองเสียบหฟูง

ตอลําโพงภายนอกเขากบัแจ็คเสียงทีอ่ยูบนการดเสียงทีเ่พิ่งติดตัง้ผดิอัน ดเูอกสารทีม่าพรอมกับการดเสียงเพื่อดกูารตอลําโพงทีถู่กตอง

ไมไดเปดใชระบบเสยีงดิจิตอลซีดี เปดใชระบบเสียงดิจิตอลซีด ีใน Device Manager ใหคลิกขวาที่อุปกรณ
ซีด/ีดวีีด ีและเลือก Properties ตรวจดูวามีการเลือก Enable digital
CD audio for this CD-ROM device

หฟูงหรืออุปกรณทีต่อเขากบัชองเสียบสัญญาณเสียงออกทาํใหลําโพงภาย
ในระบบไมมีเสียง

เปดและใชหฟูงหรือลําโพงภายนอกหากตอไว หรือถอดอุปกรณเหลานีอ้อก

คอมพิวเตอรอยูในโหมด สแตนดบาย กดปุมเพาเวอรเพ่ือออกจากโหมด สแตนดบาย

ขอควรระวงั: เมื่อพยายามจะทํางานตอจากโหมด สแตนดบาย อยากดปุม
เพาเวอรนานเกนิสี่วินาท ีมิฉะนัน้ คอมพิวเตอรจะปดลง และคณุจะสูญเสีย
ขอมูลทีย่งัไมไดจัดเกบ็

มกีารยกเลิกลําโพงภายในการตัง้คาคอมพวิเตอร เปดใชงานลําโพงภายในในการตัง้คาคอมพวิเตอร เลือก Advanced >
Device Options > Internal Speaker
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เสยีงจากหฟูงไมชดัหรอือูอี้

สาเหตุ วธิแีกไข

หฟูงถกูเสียบเขาทีช่องเสียงสัญญาณเสียงออกทีด่านหลัง ชองเสียงสัญญาณ
เสียงออกทีด่านหลังใชสําหรับอุปกรณเสียงทีม่ีกําลังไฟ และไมไดออกแบบ
ใหใชกบัหูฟง

เสียบหฟูงทีช่องเสียบหูฟงดานหนาของเคร่ือง

คอมพวิเตอรคางในระหวางการบนัทกึเสยีง

สาเหตุ วธิแีกไข

ฮารดดสิกอาจเตม็ กอนที่จะบันทกึเสียง ใหตรวจดวูามีเนื้อท่ีวางบนฮารดดสิกเพียงพอ หรือคณุ
อาจใชวิธบีันทกึไฟลเสียงในรูปแบบบีบอัดขอมูล

แจค็ของสญัญาณเสยีงเขาทาํงานไมถกูตอง

สาเหตุ วธิแีกไข

มกีารกําหนดคาใหมใหกบัแจ็คในไดรเวอรระบบเสียงหรือซอฟตแวรแอ
ปพลิเคชนั

เมื่ออยูในไดรเวอรระบบเสียงหรือซอฟตแวรแอปพลิเคชัน ใหกําหนดคา
ใหมใหกบัแจ็คหรือตัง้คาแจ็คกลับเปนคาดีฟอลต

ตาราง 2-7  การแกไขปญหาเกีย่วกบัระบบเสียง (ตอ)
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การแกไขปญหาของเครือ่งพมิพ
หากคณุพบปญหาเก่ียวกับเคร่ืองพิมพ โปรดอานเอกสารที่มาพรอมกับเคร่ืองพิมพ และรายการสาเหตแุละการแกไขปญหาที่
พบบอยในตารางตอไปน้ี

ตาราง 2-8  การแกไขปญหาของเครื่องพมิพ

เครื่องพมิพไมทาํงาน

สาเหตุ วธิแีกไข

ไมไดเปดเคร่ืองพมิพหรือเคร่ืองไมอยูในโหมดออนไลน เปดเคร่ืองพมิพและตรวจสอบวาอยูในโหมดออนไลนแลว

ไมไดตดิตัง้ไดรเวอรเคร่ืองพมิพเวอรชนัที่ถกูตอง 1. ตดิตัง้ไดรเวอรในเวอรชนัทีถ่กูตองสําหรับแอปพลิเคชันของคณุ

2. ลองพมิพโดยใชคําสั่งของ MS-DOS:

DIR C:\ > [พอรตของเครื่องพิมพ]

โดยที ่[พอรตของเคร่ืองพิมพ] เปนแอดเดรสที่เคร่ืองพมิพใช หาก
เคร่ืองพมิพทํางาน ใหโหลดไดรเวอรของเคร่ืองพมิพใหม

หากคณุอยูในเน็ตเวิรก คณุอาจไมมีการเชือ่มตอไปยงัเคร่ืองพมิพ ทาํการเชือ่มตอไปยงัเคร่ืองพิมพ

เคร่ืองพมิพอาจขัดของ รันการทดสอบโดยอัตโนมัติของเคร่ืองพิมพ

ไมสามารถเปดเครือ่งพมิพ

สาเหตุ วธิแีกไข

ตอสายไมถกูตอง ตอสายเคเบิลทัง้หมดอีกคร้ังและตรวจสอบสายไฟและปล๊ักเสียบ

เครื่องพมิพพมิพขอมลูทีอ่านไมออก

สาเหตุ วธิแีกไข

ไมไดตดิตัง้ไดรเวอรเคร่ืองพมิพเวอรชนัที่ถกูตอง ตดิตัง้ไดรเวอรในเวอรชนัทีถ่กูตองสําหรับแอปพลิเคชันของคณุ

ตอสายไมถกูตอง ตอสายเคเบิลทั้งหมดอีกคร้ัง

อาจมีการใชงานหนวยความจําของเครื่องพิมพมากเกนิไป รีเซ็ตเคร่ืองพมิพดวยการปดเปนเวลา 1 นาท ีและเปดใหมอีกคร้ัง

เครื่องพมิพอยูในสถานะออฟไลน

สาเหตุ วธิแีกไข

กระดาษในเครื่องพมิพอาจหมด ตรวจสอบถาดปอนกระดาษและเติมกระดาษใหเตม็ เลือกโหมดออนไลน
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การแกไขปญหาเกีย่วกบัแปนพมิพและเมาส
หากคุณพบปญหาเก่ียวกับแปนพิมพหรือเมาส โปรดอานเอกสารที่มาพรอมกับอุปกรณและดรูายการสาเหตุและการแกไข
ปญหาโดยทั่วไปในตารางตอไปน้ี

ตาราง 2-9  การแกไขปญหาเกีย่วกบัแปนพมิพ

คอมพวิเตอรไมรับรูคาํสัง่จากแปนพมิพและการพมิพ

สาเหตุ วธิแีกไข

ตอสายเขากบัชองเสียบแปนพิมพไมถูกตอง 1. บนเดสกทอปของระบบปฏิบัตกิาร Windows XP ใหคลิก Start >
Shut Down

บนเดสกทอปของ Windows Vista ใหคลิก เริม่ คลิกลูกศรทีมุ่มขวา
ลางของเมนูเร่ิม และเลือก ปดเครือ่ง

2. หลังจากปดเคร่ืองเรียบรอยแลว เสียบสายแปนพมิพเขากบั
คอมพวิเตอรใหมอีกคร้ังและรีสตารทคอมพวิเตอร

โปรแกรมที่ใชอยูหยดุตอบสนองตอคําสัง่ตางๆ ปดคอมพวิเตอรของคณุ โดยใชเมาส จากนัน้รีสตารทคอมพิวเตอร

อาจตองซอมแปนพิมพ โปรดดูขอกําหนดและเงื่อนไขสําหรับการรับประกนัแบบจํากดัทัว่โลก

คอมพิวเตอรอยูในโหมด สแตนดบาย กดปุมเพาเวอรเพื่อออกจากโหมด สแตนดบาย

ขอควรระวงั: เมื่อพยายามจะทํางานตอจากโหมด สแตนดบาย อยากดปุม
เพาเวอรนานเกินสี่วินาท ีมิฉะนั้น คอมพวิเตอรจะปดลง และคณุจะสูญเสีย
ขอมูลที่ยงัไมไดจัดเกบ็

เคอรเซอรไมเคลือ่นไหวเมือ่ใชปุม ลูกศร บนแปนพมิพ

สาเหตุ วธิแีกไข

ปุม Num Lock อาจอยูในสถานะใชงาน กดปุม Num Lock ไฟสถานะ Num Lock ไมควรจะเปดอยูหากคณุตอง
การใชปุม ลูกศร สามารถเปด (หรือปดการใชงาน) ปุม Num Lock ไดใน
ยทูลิิตีการตัง้คาคอมพวิเตอร

ตาราง 2-10  การแกไขปญหาเมาส

เมาสไมตอบสนองตอการเคลือ่นไหวหรือตอบสนองชาเกนิไป

สาเหตุ วธิแีกไข

เสียบสายเมาสเขากบัเคร่ืองคอมพิวเตอรไมถกูตอง ปดคอมพิวเตอรของคณุโดยใชแปนพิมพ

1. กดปุม Ctrl และ Esc พรอมกนั (หรือกดปุม Windows logo) เพือ่
เขาสูเมน ูStart

2. ใชปุม ลูกศร เพื่อเลือก Shut Down และกดปุม Enter

3. หลังจากปดเคร่ืองเรียบรอยแลว เสียบเมาสเขากับดานหลังของ
คอมพิวเตอร (หรือแปนพมิพ) และรีสตารทคอมพวิเตอร

โปรแกรมที่ใชอยูหยดุตอบสนองตอคําสัง่ตางๆ ปดคอมพวิเตอรของคณุ โดยใชแปนพมิพ จากนั้นรีสตารทคอมพิวเตอร

อาจจําเปนตองทาํความสะอาดเมาส ถอดฝาครอบลูกกล้ิงจากดานลางของเมาสออก และทําความสะอาดสวน
ประกอบภายใน

อาจจําเปนตองซอมแซมเมาส โปรดดูขอกําหนดและเงื่อนไขสําหรับการรับประกนัแบบจํากดัทัว่โลก

คอมพิวเตอรอยูในโหมด สแตนดบาย กดปุมเพาเวอรเพื่อออกจากโหมด สแตนดบาย
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เมาสไมตอบสนองตอการเคลื่อนไหวหรือตอบสนองชาเกนิไป

สาเหตุ วธิแีกไข

ขอควรระวงั: เมื่อพยายามจะทํางานตอจากโหมด สแตนดบาย อยากดปุม
เพาเวอรนานเกนิสี่วินาท ีมิฉะนัน้ คอมพิวเตอรจะปดลง และคณุจะสูญเสีย
ขอมูลทีย่งัไมไดจัดเกบ็

เมาสเคลือ่นในแนวตัง้หรอืแนวนอนเทานัน้ หรือมกีารกระตกุ

สาเหตุ วธิแีกไข

บอลลูกกล้ิงของเมาสหรือแกนตัวถอดรหัสทีก่ําลังหมุนที่สัมผสักบัเมาส
สกปรก

ถอดฝาครอบลูกกล้ิงจากดานลางของเมาสออกและทาํความสะอาดสวน
ประกอบภายในดวยชดุทาํความสะอาดเมาสทีม่ีขายในรานคอมพิวเตอรทั่ว
ไป

ตาราง 2-10  การแกไขปญหาเมาส (ตอ)
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การแกไขปญหาในการติดตัง้ฮารดแวร
คุณอาจตองตั้งคาคอมพิวเตอรใหมเม่ือคุณเพ่ิมหรือถอดฮารดแวร เชน ไดรฟหรือการดเอ็กซแพนชนัเพ่ิมเติม หากคุณตดิตั้ง
อุปกรณแบบปลั๊กแอนดเพลย Windows จะรับรูถึงอุปกรณน้ันและตัง้คาคอนฟเกอเรชนัของระบบไดโดยอัตโนมัติ หากคณุ
ติดตั้งอุปกรณที่ไมใชแบบปลั๊กแอนดเพลย คุณจะตองตั้งคาระบบคอมพิวเตอรใหมหลังจากตดิตั้งฮารดแวร ใน Windows ให
ใช ตวัชวยสรางการเพิม่ฮารดแวร และปฏิบัติตามคําแนะนําบนหนาจอ

คาํเตอืน! เม่ือตอสายไฟกับเคร่ืองคอมพิวเตอร แหลงจายไฟจะมีแรงดันไฟฟาสําหรับเมนบอรดอยูตลอดเวลา เพ่ือลดความ
เส่ียงที่จะไดรับบาดเจ็บจากไฟฟาช็อต และ/หรือพ้ืนผวิที่รอน คณุควรตรวจดใูหแนใจวา ไดถอดปล๊ักไฟแลว และปลอยใหสวน
ประกอบภายในของระบบเยน็กอนจะสัมผัส

ตาราง 2-11  การแกไขปญหาในการตดิตัง้ฮารดแวร

คอมพวิเตอรไมรบัรูอปุกรณใหมวาเปนสวนหนึง่ของระบบ

สาเหตุ วธิแีกไข

ไมไดตดิตัง้หรือเชือ่มตออุปกรณอยางเหมาะสม ตรวจสอบวาไดตดิตัง้หรือเชื่อมตออุปกรณอยางถูกตองและแนนหนา และ
ขาของชองเสียบไมหักหรืองอ

สายเคเบิลของอุปกรณภายนอกชิ้นใหมไมแนนหรือไมไดเสียบสายไฟ ตรวจสอบวาไดตดิตัง้หรือเชื่อมตออุปกรณอยางถูกตองและแนนหนา และ
ขาของชองเสียบไมหักหรืองอ

ไมไดเปดสวิตชเพาเวอรของอุปกรณภายนอก ปดเคร่ืองคอมพวิเตอร เปดอุปกรณภายนอก จากนั้นเปดเคร่ืองคอมพวิเตอร
เพื่อใหอุปกรณใหมรวมอยูในระบบของคอมพวิเตอร

คณุไมไดปฏิบตัิตามที่เคร่ืองคอมพวิเตอรแนะนําใหแกไขการตั้งคา บตูระบบใหมและทาํตามคําแนะนาํเพือ่ยอมรับการแกไข

การดแบบพลักแอนดเพลยอาจไมไดรับการตั้งคาโดยอัตโนมัตใินขณะที่
เพิ่มเขาสูระบบ หากการตัง้คาดฟีอลตมีขอขดัแยงกับอุปกรณอื่น

ใชโปรแกรม Windows Device Manager เพื่อยกเลิกการเลือกคา
อัตโนมัตขิองการด และเลือกการตัง้คาพืน้ฐานทีไ่มทําใหเกดิขอขัดแยง
นอกจากนีคุ้ณยงัสามารถใชยทูลิิตกีารตัง้คาคอมพิวเตอรเพ่ือกําหนดคาใหม
หรือตัดการทํางานของอปุกรณเพือ่แกไขปญหาความขัดแยง

พอรต USB บนคอมพิวเตอรถกูปดการใชงานในโปรแกรมการตัง้คาเคร่ือง
คอมพิวเตอร

เขาสูโปรแกรมการตั้งคาคอมพวิเตอร (F10) และเปดใชพอรต USB

คอมพวิเตอรไมทาํงาน

สาเหตุ วธิแีกไข

โมดูลหนวยความจําทีไ่มถกูตองถกูใชในเวอรชันอัพเกรด หรือโมดูลหนวย
ความจําถกูติดตั้งในตําแหนงทีไ่มถกูตอง

1. โปรดอานเอกสารทีม่าพรอมกบัเคร่ืองคอมพิวเตอรเพือ่ตรวจวาคณุ
ใชโมดลูหนวยความจําและวิธกีารตดิตัง้ที่ถกูตอง

หมายเหต:ุ DIMM 1 ตองติดตัง้ไวอยูแลว

2. สงัเกตเสียงและไฟสถานะทีแ่ผงดานหนาของคอมพวิเตอร เสียง
บี๊ปและไฟทีก่ะพริบหมายถงึรหสัของปญหาเฉพาะ

3. หากคณุยงัไมสามารถแกปญหาได โปรดตดิตอฝายบริการลูกคา
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ไฟสถานะเปดเครือ่งกะพรบิเปนสแีดง 5 ครัง้ทกุๆ วินาท ีจากนัน้เวน 2 วนิาท ีและคอมพวิเตอรสงสญัญาณเสยีง 5 ครัง้ (เสียงเตอืนจะหยดุหลังจากดงัตดิ
ตอกนัเปนครัง้ที ่5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วธิแีกไข

หนวยความจําเสียหายหรือตดิตัง้ไมถกูตอง ขอควรระวงั: ในการหลีกเล่ียงความเสียหายของ DIMM หรือเมนบอรด
คณุตองถอดปลั๊กคอมพิวเตอรกอนทีจ่ะพยายามตอ ติดตั้ง หรือนําโมดลู
DIMM ออก

1. ใส DIMM ใหมอีกคร้ัง เปดเคร่ืองคอมพวิเตอร

2. เปล่ียน DIMM ทีละชิ้น เพื่อแยกโมดลูทีม่ีขอผิดพลาดออก

หมายเหต:ุ DIMM 1 ตองตดิตัง้ไวอยูแลว

3. ใชหนวยความจําของ HP แทนหนวยความจําของผูผลิตรายอื่น

4. เปล่ียนเมนบอรด

ไฟสถานะเปดเครือ่งกะพรบิเปนสแีดง 6 ครัง้ทกุๆ วินาท ีจากนัน้เวน 2 วนิาท ีและคอมพวิเตอรสงสญัญาณเสยีง 6 ครัง้ (เสียงเตอืนจะหยดุหลังจากดงัตดิ
ตอกนัเปนครัง้ที ่5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วธิแีกไข

การดกราฟกเสียหายหรือตอไมถูกตอง หรือเมนบอรดไมถกูตอง สําหรับระบบทีใ่ชการดแสดงผล:

1. ตดิตัง้การดแสดงผลใหม เปดเคร่ืองคอมพิวเตอร

2. เปล่ียนการดแสดงผล

3. เปล่ียนเมนบอรด

สําหรับระบบทีใ่ชกราฟกภายใน ใหเปล่ียนเมนบอรด

ไฟสถานะเปดเครือ่งกะพรบิเปนสแีดง 10 ครัง้ทกุๆ วินาท ีจากนัน้เวน 2 วนิาท ีและคอมพวิเตอรสงสัญญาณเสยีง 10 ครั้ง (เสยีงเตอืนจะหยดุหลังจากดงั
ตดิตอกนัเปนครัง้ที ่5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วธิแีกไข

การดเสริมมีขอบกพรอง 1. ตรวจสอบการดเสริมแตละอัน โดยถอดการดออกมาทีละอัน (ในกรณี
ทีต่ิดตั้งการดหลายอัน) จากนั้นใหเปดเคร่ือง เพื่อดวูายงัมีขอบกพรอง
หรือไม

2. ถาพบการดทีผ่ิดปกต ิใหถอดออกและเปลี่ยนอันใหม

3. เปล่ียนเมนบอรด

ตาราง 2-11  การแกไขปญหาในการตดิตัง้ฮารดแวร (ตอ)
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การแกไขปญหาเกีย่วกบัเนต็เวริก
ตารางตอไปน้ีเปนสาเหตุและการแกไขปญหาเก่ียวกับเน็ตเวิรกที่พบบอย คําแนะนําเหลาน้ีจะไมกลาวถึงกระบวนการแกไข
ปญหาการวางสายเน็ตเวิรก

ตาราง 2-12  การแกไขปญหาเกีย่วกบัเนต็เวิรก

คณุสมบตั ิWake-on-LAN ไมทาํงาน

สาเหตุ วธิแีกไข

ไมไดเปดใช Wake-on-LAN ในการใชงาน Wake-on-LAN ใน Windows XP:

1. เลือก Start > Control Panel

2. ดบัเบิลคลิก Network Connections

3. ดบัเบิลคลิก Local Area Connection

4. คลิก Properties

5. คลิก Configure

6. คลิกแทบ็ Power Management แลวเลือกหรือยกเลิกการเลือก
กลองตวัเลือก Allow this device to bring the computer
out of standby

ในการใชงาน Wake-on-LAN ใน Windows Vista:

1. เลือก Start > Control Panel

2. ใต Network and Internet ใหเลือก View network status
and tasks

3. ในรายการ Tasks ใหเลือก Manage network connections

4. ดบัเบิลคลิก Local Area Connection

5. คลิกปุม Properties

6. คลิกปุม Configure

7. คลิกแทบ็ Power Management แลวเลือกกลองตัวเลือก Allow
this device to wake the computer

ไดรเวอรของเนต็เวริกไมพบคอนโทรลเลอรเนต็เวริก

สาเหตุ วธิแีกไข

ไมไดใชงานคอนโทรลเลอรเนต็เวิรก 1. รันยทูลิิตกีารตัง้คาคอมพวิเตอรและใชงานคอนโทรลเลอรเนต็เวิรก

2. เปดใชคอนโทรลเลอรเน็ตเวิรกในระบบปฏิบัติการ โดยผาน Device
Manager

ไดรเวอรเน็ตเวิรกไมถูกตอง ตรวจสอบเอกสารของคอนโทรลเลอรของเนต็เวิรกเพือ่ดูไดรเวอรทีถู่กตอง
หรือโหลดไดรเวอรลาสุดจากเว็บไซตของผูผลิต
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ไฟสถานะการเชือ่มตอเนต็เวิรกไมกะพรบิ

หมายเหต:ุ ไฟสถานะการเชือ่มตอเนต็เวริกจะตองกะพรบิเมือ่มกีารเชือ่มตอเนต็เวิรก

สาเหตุ วธิแีกไข

ไมพบเน็ตเวิรกทีใ่ชงานได ตรวจสอบการวางสายและอุปกรณของเนต็เวิรกวามีการเชือ่มตอทีเ่หมาะสม

ไมไดตัง้คาคอนโทรลเลอรเนต็เวิรกอยางถกูตอง ตรวจสอบสถานะของอุปกรณภายใน Windows เชน ตรวจสอบการโหลด
ไดรเวอรใน Device Manager และตรวจสอบสถานะการเชื่อมโยงใน
แอปเพลต Network Connections ภายใน Windows

ไมไดใชงานคอนโทรลเลอรเนต็เวิรก 1. รันยทูิลิตกีารตั้งคาคอมพวิเตอรและใชงานคอนโทรลเลอรเน็ตเวิรก

2. เปดใชคอนโทรลเลอรเน็ตเวิรกในระบบปฏิบัติการ โดยผาน Device
Manager

ไมไดโหลดไดรเวอรของเนต็เวิรกอยางถกูตอง ตดิตัง้ไดรเวอรเนต็เวิรกใหม

ระบบไมสามารถตรวจจับเนต็เวิรกโดยอัตโนมัติ เลิกใชคณุสมบัตกิารตรวจจับอัตโนมัตแิละกําหนดใหระบบเขาสูโหมดการ
ทาํงานทีถู่กตอง

โปรแกรมวนิจิฉยัรายงานขอขดัของ

สาเหตุ วธิแีกไข

ตอสายเคเบิลไมแนน ตรวจสอบวาตอสายเคเบิลไวอยางแนนหนากบัชองเสียบของเนต็เวิรก และ
ปลายอีกดานของสายตอกบัอุปกรณทีถ่กูตอง

สายเคเบิลไมไดตอกบัชองเสียบที่ถกูตอง ตรวจสอบวามีการตอสายเคเบิลกับชองเสียบทีถู่กตอง

มปีญหาเกีย่วกบัสายเคเบลิหรืออุปกรณทีป่ลายอกีดานของสาย ตรวจสอบวาสายเคเบิลและอุปกรณทีป่ลายสายทํางานถกูตอง

คาอินเทอรัปตของคอนโทรลเลอรเนต็เวิรกถูกใชรวมกบัการดเอ็กซแพนชัน
อื่น

ในเมน ูAdvanced ของยทูลิิตกีารตัง้คาคอมพิวเตอร ใหเปล่ียนการตัง้คา
ทรัพยากรของการด

คอนโทรลเลอรเนต็เวิรกเสีย ตดิตอผูใหบริการทีไ่ดรับอนุญาต

การวนิจิฉยัผาน แตคอมพวิเตอรไมทาํงานรวมกบัเนต็เวริก

สาเหตุ วธิแีกไข

ไมไดโหลดไดรเวอรของเนต็เวิรก หรือพารามิเตอรของเนต็เวิรกไมตรงกบั
การตัง้คาปจจุบัน

ตรวจสอบวามีการโหลดไดรเวอรที่ถกูตอง และพารามิเตอรของเนต็เวิรก
ตรงกบัการตัง้คาของระบบ

ตรวจสอบวาไดตดิตัง้ไคลเอนตและโปรโตคอลของเน็ตเวิรกแลว

คอนโทรลเลอรเนต็เวิรกไมไดรับการตั้งคาสําหรับคอมพิวเตอรนี้ เลือกไอคอน Network ใน Control Panel และตัง้คาคอนโทร
ลเลอรเน็ตเวิรก

คอนโทรลเลอรเนต็เวริกหยดุทาํงานเมือ่มกีารเพิม่การดเอก็ซแพนชนัในคอมพวิเตอร

สาเหตุ วธิแีกไข

คาอินเทอรัปตของคอนโทรลเลอรเนต็เวิรกถูกใชรวมกบัการดเอ็กซแพนชัน
อื่น

ในเมน ูAdvanced ของยทูลิิตกีารตัง้คาคอมพิวเตอร ใหเปล่ียนการตัง้คา
ทรัพยากรของการด

ตาราง 2-12  การแกไขปญหาเกีย่วกบัเนต็เวริก (ตอ)
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คอนโทรลเลอรเนต็เวริกหยดุทาํงานเมือ่มกีารเพิม่การดเอก็ซแพนชนัในคอมพวิเตอร

สาเหตุ วธิแีกไข

คอนโทรลเลอรเนต็เวิรกจําเปนตองใชไดรเวอร ตรวจสอบวาไดรเวอรไมไดถกูลบไปโดยไมไดตั้งใจขณะทีต่ดิตั้งการดเอ็กซ
แพนชันใหม

การดเอ็กซแพนชนัทีต่ิดตั้งเปนการดเน็ตเวิรก (NIC) และมีขอขดัแยงกับ
NIC ภายในระบบ

ในเมน ูAdvanced ของยทูลิิตีการตัง้คาคอมพวิเตอร ใหเปล่ียนการตัง้คา
ทรัพยากรของการด

คอนโทรลเลอรเนต็เวริกหยดุทาํงานโดยไมมสีาเหตแุนชดั

สาเหตุ วธิแีกไข

ไฟลทีบ่รรจุไดรเวอรของเนต็เวิรกเสียหาย ตดิตัง้ไดรฟเวอรเครือขายใหม โดยการใชชดุแผนดสิกสําหรับการเรียกคืน
ทีไ่ดสรางจาก Recovery Partition ของฮารดไดรฟ

ตอสายเคเบิลไมแนน ตรวจสอบวาตอสายเคเบิลไวอยางแนนหนากบัชองเสียบของเนต็เวิรก และ
ปลายอีกดานของสายตอกับอปุกรณทีถ่กูตอง

คอนโทรลเลอรเนต็เวิรกเสีย ตดิตอผูใหบริการทีไ่ดรับอนุญาต

ไมสามารถบตูดวยการดเนต็เวริกใหม

สาเหตุ วธิแีกไข

การดเนต็เวิรกใหมอาจมีขอบกพรอง หรือไมเปนไปตามมาตรฐาน ตดิตัง้ NIC แบบมาตรฐานทีส่ามารถใชการได หรือเปล่ียนลําดับการบูตเพือ่
เร่ิมตนระบบโดยใชอุปกรณอื่น

ไมสามารถเชือ่มตอกบัเซิรฟเวอรของเนต็เวริกขณะพยายามใชการตดิตัง้ระบบจากเครื่องอืน่

สาเหตุ วธิแีกไข

ไมไดตัง้คาคอนโทรลเลอรเน็ตเวิรกไวอยางถกูตอง ตรวจสอบการเชือ่มตอเน็ตเวิรก เพื่อดวูามีเซิรฟเวอร DHCP อยูหรือไม
และเซิรฟเวอรการติดตั้งระบบจากเครื่องอื่นมีไดรเวอร NIC สําหรับ NIC
ของคุณ

ยทูลิิตกีารตัง้คาระบบรายงาน EEPROM ทีไ่มไดโปรแกรม

สาเหตุ วธิแีกไข

EEPROM ทีไ่มไดโปรแกรม ตดิตอผูใหบริการทีไ่ดรับอนุญาต

ตาราง 2-12  การแกไขปญหาเกีย่วกบัเนต็เวิรก (ตอ)
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การแกไขปญหาเกีย่วกบัหนวยความจาํ
หากคณุพบปญหาเก่ียวกับหนวยความจํา โปรดอานสาเหตุและการแกไขปญหาที่พบบอยในตารางตอไปน้ี

ขอควรระวงั: อาจมีการปอนกําลังไฟใหกับ DIMMs อยูตอไปเม่ือปดคอมพิวเตอรแลว (ขึ้นอยูกับการตั้งคา Management
Engine (ME) ในการหลีกเล่ียงความเสียหายของ DIMM หรือเมนบอรด คุณตองถอดปลั๊กคอมพิวเตอรกอนที่จะพยายามตอ
ติดตั้ง หรือนําโมดูล DIMM ออก

สําหรับระบบที่สามารถใชหนวยความจํา ECC น้ัน HP จะไมรองรับการใชหนวยความจําแบบ ECC และไมใช ECC รวม
กัน มิฉะน้ัน คอมพิวเตอรจะไมบูตระบบปฏิบัติการ

หมายเหต:ุ ตัวนับหนวยความจําจะไดรับผลกระทบจากการกําหนดคาขณะที่เปดใช Management Engine (ME) ME ใช
หนวยความจําระบบขนาด 8MB ในโหมดแชนแนลเดี่ยว หรือใชหนวยความจําขนาด 16 MB ในโหมดแชน แนลคูเพ่ือ
ดาวนโหลด คลายขนาด และดําเนินการเฟรมแวร ME สําหรับ Out-of-Band (OOB) การจัดเก็บขอมูลของบริษัทอ่ืน และ
ฟงกชนัการจัดการอ่ืนๆ

ตาราง 2-13  การแกไขปญหาเกีย่วกบัหนวยความจาํ

ระบบไมบตูหรอืทาํงานไมถกูตองหลังจากตดิตัง้หนวยความจาํเพิม่เตมิ

สาเหตุ วธิแีกไข

โมดลูหนวยความจําไมไดถกูติดตั้งไวในซ็อคเกต็ XMM1 (หรือ DIMM1) โปรดตรวจดใูหแนใจวาโมดูลหนวยความจําถูกตดิตัง้ไวในซ็อคเกต็
XMM1 (หรือ DIMM1) สีดําในเมนบอรดแลว ซ็อกเกต็นีต้องมีโมดูลหนวย
ความจําดวย

โมดลูหนวยความจําเปนประเภท หรือระดบัความเร็วทีไ่มถกูตองสําหรับ
ระบบ หรือตดิตัง้หนวยความจําไมถกูตอง

เปล่ียนไปใชอุปกรณมาตรฐานสําหรับระบบของคุณ ในคอมพวิเตอรบางรุน
หนวยความจํา ECC และทีไ่มใช ECC จะไมสามารถทํางานรวมกนั

เกดิขอผดิพลาดเนือ่งจากหนวยความจาํไมเพยีงพอ

สาเหตุ วธิแีกไข

การกําหนดหนวยความจําอาจไมถกูตอง ใชโปรแกรม Device Manager เพื่อตรวจสอบการกําหนดหนวยความจํา

มหีนวยความจําไมเพยีงพอทีจ่ะรันแอปพลิเคชนั ตรวจสอบเอกสารที่มาพรอมกบัแอปพลิเคชนัเพือ่ดูขอกําหนดเกีย่วกบั
หนวยความจํา

การนบัหนวยความจาํระหวางกระบวนการ POST ไมถกูตอง

สาเหตุ วธิแีกไข

อาจตดิตัง้โมดลูหนวยความจําไมถกูตอง ตรวจสอบวาหนวยความจําทัง้หมดถกูตดิตัง้อยางถกูตองและใชโมดลูที่ถกู
ตอง

กราฟกภายในอาจใชหนวยความจําระบบ ไมตองดําเนนิการใดๆ

เกดิขอผดิพลาดเนือ่งจากหนวยความจาํไมเพยีงพอขณะทาํงาน

สาเหตุ วธิแีกไข

มีโปรแกรมประเภท TSR ติดตั้งอยูมากเกนิไป ลบโปรแกรม TSR ทีไ่มตองการใชออก

มหีนวยความจําไมเพยีงพอทีจ่ะรันแอปพลิเคชนั ตรวจสอบความตองการหนวยความจําของแอปพลิเคชนั หรือเพิม่หนวย
ความจําใหกบัระบบ

THWW การแกไขปญหาเก่ียวกับหนวยความจํา 37



ไฟสถานะเปดเครื่องกะพรบิเปนสแีดง 5 ครั้งทกุๆ วนิาท ีจากนัน้เวน 2 วนิาท ีและคอมพวิเตอรสงสัญญาณเสยีง 5 ครัง้ (เสยีงเตอืนจะหยดุหลงัจากดงัตดิ
ตอกนัเปนครั้งที ่5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วธิแีกไข

หนวยความจําเสียหายหรือตดิตั้งไมถกูตอง 1. ใส DIMM ใหมอีกคร้ัง เปดเคร่ืองคอมพวิเตอร

2. เปล่ียน DIMM ทลีะชิน้ เพื่อแยกโมดลูท่ีมีขอผิดพลาดออก

3. ใชหนวยความจําของ HP แทนหนวยความจําของผูผลิตรายอื่น

4. เปล่ียนเมนบอรด

ตาราง 2-13  การแกไขปญหาเกีย่วกบัหนวยความจาํ (ตอ)
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การแกไขปญหาเกีย่วกบัโปรเซสเซอร
หากคณุพบปญหาเก่ียวกับโปรเซสเซอร โปรดอานสาเหตุและการแกไขปญหาที่พบบอยในตารางตอไปนี้

ตาราง 2-14  การแกไขปญหาเกีย่วกบัโปรเซสเซอร

มกีารทาํงานอยางไมเตม็ประสิทธภิาพ

สาเหตุ วธิแีกไข

โปรเซสเซอรมีอุณหภูมิสูง 1. ตรวจสอบวาชองระบายอากาศถกูปดกัน้หรือไม

2. ตรวจดวูาพดัลมถกูเชือ่มตอและทํางานอยางถกูตอง (พัดลมบางตัวทํา
งานเมื่อจําเปนเทานัน้)

3. ตรวจสอบวาตัวระบายความรอนของโปรเซสเซอรถกูติดตั้งอยางถูก
ตอง

ไฟสถานะเปดเครือ่งสแีดงกะพรบิ 3 ครัง้ทกุๆ วนิาท ีจากนัน้เวน 2 วินาที

สาเหตุ วธิแีกไข

ไมไดตอหรือตดิตัง้โปรเซสเซอรอยางถกูตอง 1. ตรวจดวูามีโปรเซสเซอรอยูในเคร่ืองหรือไม

2. ตดิตัง้โปรเซสเซอรอีกคร้ัง

ไฟสถานะเปดเครือ่งสแีดงกะพรบิแปดครั้งทกุๆ วนิาท ีจากนัน้เวนสองวนิาที

สาเหตุ วธิแีกไข

โปรเซสเซอรปจจุบันไมรองรับคุณสมบัติทีใ่ชงานกอนหนานี้บนระบบนี้ 1. ตดิตัง้โปรเซสเซอร TXT เทาทีต่องการ

2. ยกเลิกใชงาน TXT ในยูทลิิตีการตั้งคาคอมพวิเตอร (F10)

3. ตดิตัง้โปรเซสเซอรเดมิซ้ํา
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การแกไขปญหาซดีรีอมและดวีดีี
หากคุณพบปญหาเก่ียวกับซีดีรอมและดีวีดี โปรดดูสาเหตแุละวิธีแกไขปญหาที่พบบอยในตารางตอไปน้ี และในเอกสารที่มา
พรอมกับอุปกรณเสริมดังกลาว

ตาราง 2-15  การแกไขปญหาซดีีรอมและดีวดีี

ระบบไมบตูจากไดรฟซดีรีอมหรือดวีีดี

สาเหตุ วธิแีกไข

อปุกรณติดตั้งลงในพอรต SATA ทีไ่มถกูซอนไวในยทูิลิตกีารตั้งคา
คอมพิวเตอร

รันยทูลิิตกีารตัง้คาคอมพิวเตอร และโปรดตรวจสอบใหแนใจวาเลือก
Device Available สําหรับพอรต SATA ของอุปกรณใน Security >
Device Security ไวแลว

Removable Media Boot ถกูยกเลิกการใชงานในยทูลิิตีการตั้งคา
คอมพิวเตอร

รันยทูลิิตกีารตัง้คาคอมพิวเตอร และเปดใชการบูตไปยงัสื่อที่ถอดออกไดใน
Storage > Storage Options ตรวจสอบวาไดเปดใชซดีีรอมใน
Storage > Boot Order

Network Server Mode ถกูยกเลิกการใชงานในยทูิลิตกีารตั้งคา
คอมพิวเตอร

รันยทูลิิตกีารตัง้คาคอมพิวเตอร และยกเลิกการใช Network Server
Mode ใน Security > Password Options

มแีผนซีดีทีบู่ตไมไดอยูในไดรฟ ลองใชแผนซีดทีี่บูตได

ลําดับการบูตไมถกูตอง รันยทูลิิตกีารตัง้คาคอมพิวเตอร แลวเปล่ียนลําดับการบูตใน Storage >
Boot Order

ไมพบไดรฟ (ทีร่ะบุ)

สาเหตุ วธิแีกไข

สายเคเบิลอาจหลวม ตรวจสอบการตอสายเคเบิล

ระบบอาจไมรับทราบถงึไดรฟทีต่ดิตัง้ขึน้ใหมไดโดยอัตโนมัติ โปรดดูคาํแนะนาํในการตัง้คาใหมในหัวขอ การแกไขปญหาในการตดิตั้ง
ฮารดแวร ในหนา 32 หากระบบยงัไมรับรูถงึอุปกรณใหม ใหตรวจสอบวามี
อปุกรณนัน้แสดงอยูภายในยทูลิิตีการตัง้คาคอมพวิเตอรหรือไม หากมีอยู
สาเหตุของปญหาอาจอยูทีไ่ดรเวอร แตหากไมมีอุปกรณดังกลาวอยู ปญหานี้
อาจเกดิจากฮารดแวร

หากไดรฟนัน้เปนไดรฟที่ตดิตัง้ใหม ใหรันยทูิลิตกีารตั้งคาคอมพวิเตอร
และลองเพิ่มระยะเวลาการรอในกระบวนการ POST ที่ Advanced >
Power-On Options

อปุกรณติดตั้งลงในพอรต SATA ทีถ่กูซอนไวในยทูิลิตีการตั้งคา
คอมพิวเตอร

รันยทูลิิตกีารตัง้คาคอมพิวเตอร และโปรดตรวจสอบใหแนใจวาเลือก
Device Available สําหรับพอรต SATA ของอุปกรณใน Security >
Device Security ไวแลว

ไดรฟตอบสนองชาหลังจากการเริ่มตนระบบ รันยทูลิิตกีารตัง้คาคอมพิวเตอร และเพิ่มเวลารอของกระบวนการ POST
ใน Advanced > Power-On Options

ไมพบหรอืไมไดโหลดไดรเวอรของอปุกรณซดีรีอมหรือดวีดีี

สาเหตุ วธิแีกไข

ไมไดตอหรือตั้งคาไดรฟไวอยางเหมาะสม โปรดดูเอกสารทีม่าพรอมกบัอุปกรณเสริม
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ไมสามารถเปดภาพยนตจากไดรฟดวีดีี

สาเหตุ วธิแีกไข

ภาพยนตนั้นอาจถูกกําหนดพืน้ทีไ่วสําหรับประเทศ/พื้นทีอ่ื่น โปรดดเูอกสารที่มาพรอมกบัไดรฟดวีีดี

ไมไดตดิตัง้ซอฟตแวรแปลงสัญญาณ ตดิตัง้ซอฟตแวรแปลงสญัญาณ

สื่อไดรับความเสียหาย เปล่ียนสื่อ

มกีารล็อคเรตติง้ภาพยนตร ใชซอฟตแวรดีวีดีเพ่ือยกเลิกการล็อค

ใสสื่อในลักษณะกลับหวั ใสสื่อใหมอีกคร้ัง

นาํดสิกออกจากไดรฟไมได (ไดรฟแบบถาด)

สาเหตุ วธิแีกไข

ใสแผนดิสกในไดรฟไมถกูตอง ปดระบบคอมพวิเตอรและสอดลวดโลหะเล็กๆ ในชองนําดสิกออกฉกุเฉนิ
และดันเขา คอยๆ ดงึถาดออกจากไดรฟจนกระทัง่สุด จากนัน้นําดิสกออกมา

ไดรฟ CD-ROM, CD-RW, DVD-ROM หรอื DVD-R/RW ไมสามารถอานดสิกหรอืใชเวลาในการเริ่มทาํงานนานเกนิไป

สาเหตุ วธิแีกไข

ใสส่ือผิดดาน ใสส่ือใหมโดยใหดานฉลากอยูดานบน

ไดรฟ DVD-ROM ใชเวลานานในการเริ่มตนเพราะตองกาํหนดชนิดของ
สื่อ เชน เสียงหรือภาพ

รอเปนเวลาอยางนอย 30 วินาทเีพื่อใหไดรฟ DVD-ROM กาํหนดชนดิของ
สื่อทีเ่ลน หากดิสกยงัไมเร่ิมทํางาน อานวิธีแกไขอื่นๆ ทีอ่ยูในหัวขอนี้

แผนซีดหีรือดวีีดสีกปรก ทาํความสะอาดซีดหีรือดวีีดีดวยชดุทาํความสะอาดซีดี ทีม่ีขายในราน
คอมพิวเตอรสวนใหญ

Windows ไมพบไดรฟ CD-ROM หรือ DVD-ROM 1. ใช Device Manager เพื่อถอดหรือถอนการติดตั้งอุปกรณดงักลาว

2. รีสตารทคอมพิวเตอรของคณุใหมและให Windows คนหาไดรฟซีดี
และดีวีดี

การบันทกึหรอืการคดัลอกซดีมีปีญหาหรอืไมสามารถทาํได

สาเหตุ วธิแีกไข

ชนดิของสื่อไมถูกตองหรือมีคุณภาพไมดี 1. ลองใชความเร็วทีช่าลงเมื่อทําการบันทกึ

2. ตรวจสอบวาคุณใชสื่อทีถ่กูตองสําหรับไดรฟ

3. ลองใชสื่อยีห่ออื่น คุณภาพจะแตกตางกนัไปตามผูผลิต

คอมพวิเตอร USDT บตูชามากหลังจากถอดไดรฟ CD-ROM หรือ DVD

สาเหตุ วธิแีกไข

ระบบกําลังคนหาไดรฟในขณะทีบู่ตเนือ่งจากสายเคเบิลไดรฟยงัตอเขากบั
เมนบอรด

ถอดสายเคเบิลไดรฟออกจากเมนบอรด

ตาราง 2-15  การแกไขปญหาซีดรีอมและดีวดี ี(ตอ)
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การแกไขปญหาเกีย่วกบัแฟลชไดรฟ USB
หากคุณพบปญหาเก่ียวกับแฟลชไดรฟ USB โปรดดูสาเหตแุละวิธีแกไขปญหาที่พบบอยในตารางตอไปน้ี

ตาราง 2-16  การแกไขปญหาเกีย่วกบัแฟลชไดรฟ USB

แฟลชไดรฟ USB ไมปรากฏเปนตวัอกัษรชือ่ไดรฟใน Windows

สาเหตุ วธิแีกไข

ไมมีตวัอักษรชือ่ไดรฟตอจากไดรฟทางกายภาพตัวสุดทาย เปล่ียนตัวอักษรชือ่ไดรฟที่เปนคาดีฟอลตสําหรับแฟลชไดรฟใน
Windows

ไมพบแฟลชไดรฟ USB (ทีร่ะบไุว)

สาเหตุ วธิแีกไข

อปุกรณติดตั้งลงในพอรต USB ทีถ่กูซอนไวในยทูิลิตีการตัง้คา
คอมพิวเตอร

รันยทูลิิตกีารตัง้คาคอมพิวเตอรและดใูหแนใจวาไดเลือก "Device
available" สําหรับ "Front USB Ports" และ "Rear USB Ports" ใต
Security > Device Security แลว

อุปกรณยงัไมแนนกอนเปดเคร่ือง ดใูหแนใจวา อุปกรณยึดลงในพอรต USB ไดอยางแนนหนาแลวกอนเปด
ระบบ

ระบบจะไมบตูจากแฟลชไดรฟ USB

สาเหตุ วธิแีกไข

ลําดับการบูตไมถกูตอง รันยทูลิิตกีารตัง้คาคอมพิวเตอร แลวเปล่ียนลําดับการบูตใน Storage >
Boot Order

Removable Media Boot ถกูยกเลิกการใชงานในยทูลิิตีการตั้งคา
คอมพิวเตอร

รันยทูลิิตกีารตัง้คาคอมพิวเตอร และเปดใชการบูตไปยงัสื่อที่ถอดออกไดใน
Storage > Storage Options ตรวจสอบวา ไดเปดใช USB ใน
Storage > Boot Order

ไมสามารถบูตภาพบนอุปกรณ ปฏิบัติตามขั้นตอนทีอ่ธบิายไวใน “การแฟลช ROM: การจําลองการตัง้คา:
การสรางอุปกรณทีใ่ชบูต: อุปกรณสื่อสําหรับการแฟลชทาง USB ทีร่องรับ"
ของ Service Reference Guide

คอมพวิเตอรจะบตูไปที ่DOS หลงัจากทีท่าํแฟลชไดรฟทีส่ามารถใชบูตได

สาเหตุ วธิแีกไข

แฟลชไดรฟสามารถใชบูตได ตดิตัง้แฟลชไดรฟหลังจากทีบู่ตระบบปฏิบัตกิารแลวเทานัน้
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การแกไขปญหาสวนประกอบแผงดานหนา
หากคณุพบปญหาเก่ียวกับอุปกรณที่เชื่อมตอกับแผงดานหนา โปรดดูสาเหตุและการแกไขปญหาที่พบบอยในตารางตอไปน้ี

ตาราง 2-17  การแกไขปญหาสวนประกอบแผงดานหนา

คอมพวิเตอรไมรับรูการเชือ่มตออปุกรณ USB, หฟูง หรือไมโครโฟน

สาเหตุ วธิแีกไข

ไมไดเชือ่มตออุปกรณอยางเหมาะสม 1. ปดเคร่ืองคอมพวิเตอร

2. เชื่อมตออุปกรณอีกคร้ังทีด่านหนาของคอมพวิเตอรและเร่ิมตนการ
ทาํงานของคอมพิวเตอรใหม

อุปกรณไมไดรับกระแสไฟ หากอุปกรณ USB ตองใชไฟฟา AC โปรดแนใจวาปลายดานหนึง่เชือ่มตอ
กบัอุปกรณแลว และปลายอีกดานเชื่อมตอกบัเตารับไฟฟาทีม่ีไฟฟา

ไมไดตดิตัง้ไดรเวอรทีถ่กูตองของอุปกรณ 1. ตดิตัง้ไดรเวอรในเวอรชนัทีถ่กูตองสําหรับอุปกรณ

2. คณุอาจจะตองรีบูตคอมพวิเตอร

สายเคเบิลจากอุปกรณทีต่อกบัคอมพิวเตอรใชงานไมได 1. หากเปนไปได ใหเปล่ียนสายเคเบิล

2. เร่ิมการทํางานของคอมพิวเตอรใหม

อุปกรณไมทํางาน 1. เปล่ียนอุปกรณ

2. เร่ิมการทํางานของคอมพิวเตอรใหม

พอรต USB บนคอมพิวเตอรถกูปดการใชงานในโปรแกรมการตัง้คาเคร่ือง
คอมพิวเตอร

เขาสูโปรแกรมการตั้งคาคอมพวิเตอร (F10) และเปดใชพอรต USB
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การแกไขปญหาในการเชือ่มตออนิเทอรเนต็
หากคุณพบปญหาในการเชื่อมตออินเทอรเน็ต โปรดติดตอผูใหบริการอินเทอรเน็ต (ISP) หรือดสูาเหตุและวิธีแกไขปญหาที่
พบบอยในตารางตอไปน้ี

ตาราง 2-18  การแกไขปญหาในการเชือ่มตออนิเทอรเนต็

ไมสามารถเชือ่มตออนิเทอรเนต็

สาเหตุ วธิแีกไข

ไมไดตัง้คาบัญชอีินเทอรเน็ตอยางถกูตอง ตรวจสอบการตั้งคาอินเทอรเนต็ หรือติดตอขอความชวยเหลือจาก ISP

ตัง้คาโมเด็มไมถกูตอง ตอโมเด็มใหมอีกคร้ัง ตรวจสอบวาการเชือ่มตอถกูตองหรือไม โดยดจูาก
เอกสารการตดิตัง้อยางรวดเร็ว

ไมไดตดิตัง้เว็บเบราเซอรอยางถกูตอง ตรวจดวูาเว็บเบราเซอรไดรับการตดิตัง้และตัง้คาใหสามารถทาํงานกบั ISP
ของคุณ

ไมไดเสียบปล๊ักโมเดม็สําหรับเคเบิล/DSL เสียบปล๊ักโมเด็มสําหรับเคเบิล/DSL ไฟสถานะ “power” ทีด่านหนาของ
โมเดม็สําหรับเคเบิล/DSL ควรจะตดิ

บริการเคเบิล/DSL ไมพรอมใชงานหรือขัดของเนือ่งจากสภาพอากาศไมดี ลองเชื่อมตออินเทอรเน็ตในภายหลัง หรือติดตอ ISP ของคุณ (หากมีการ
เชือ่มตอบริการเคเบิล/DSL ไฟสถานะ “cable” ทีด่านหนาของโมเดม็
สําหรับเคเบิล/DSL ควรจะติด)

ไมไดเชือ่มตอสายเคเบิล CAT5 UTP เชือ่มตอสายเคเบิล CAT5 ระหวางเคเบิลโมเดม็กับชองเสียบ RJ-45 ของ
คอมพิวเตอร (หากการเชือ่มตอเปนปกต ิไฟสถานะ “PC” ทีด่านหนาของ
โมเดม็สําหรับเคเบิล/DSL จะติด)

กาํหนดแอดเดรส IP ไมถกูตอง ตดิตอ ISP ของคุณเพื่อสอบถามแอดเดรส IP ทีถู่กตอง

คกุกีไ้ดรับความเสียหาย („คุกกี“้ คอืขอมูลขนาดเล็กท่ีเว็บเซิรฟเวอรสามารถ
จัดเก็บชั่วคราวไวพรอมกับเว็บเบราเซอรของคุณ เพือ่ใหเบราเซอรของคุณ
จดจําขอมูลเฉพาะบางอยางซึ่งเว็บเซิรฟเวอรจะสามารถเรียกดูในภายหลัง)

Windows Vista

1. เลือก Start > Control Panel

2. คลิก Network and Internet.

3. คลิก Internet Options.

4. ในหวัขอ Browsing history บนแทบ็ General ใหคลิกปุม
Delete

5. คลิกทีปุ่ม Delete cookies

Windows XP

1. เลือก Start > Control Panel

2. ดบัเบิลคลิก Internet Options

3. บนแทบ็ General ใหคลิกทีปุ่ม Delete Cookies

ไมสามารถเปดโปรแกรมอนิเทอรเนต็โดยอตัโนมตัิ

สาเหตุ วธิแีกไข

คณุจะตองล็อกออนเขาสูระบบของ ISP เสียกอน บางโปรแกรมจึงจะ
สามารถเริ่มตนการทาํงานได

ล็อกออนเขาสูระบบของ ISP แลวเปดโปรแกรมที่ตองการ
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ใชเวลานานเกนิไปในการดาวนโหลดเวบ็ไซต

สาเหตุ วธิแีกไข

ตัง้คาโมเด็มไมถกูตอง ตรวจสอบวา ไดเชือ่มตอโมเด็มแลว และโมเดม็กําลังสื่อสารไดอยางเหมาะ
สม

Windows XP

1. เลือก Start > Control Panel

2. ดบัเบิลคลิก System

3. คลิกแทบ็ Hardware

4. ในสวนของ Device Manager ใหคลิกปุม Device Manager

5. ดบัเบิลคลิก Modems

6. ดบัเบิลคลิก Agere Systems PCI-SV92PP Soft Modem

7. บนแทบ็ General ใหคลิก Diagnostics

8. คลิก Query Modem ขอความตอบกลับดวยคําวา “Success”
แสดงใหทราบวา เชื่อมตอโมเดม็แลวและโมเดม็ทํางานไดอยาง
เหมาะสม

Windows Vista

1. เลือก Start > Control Panel

2. คลิกที ่System and Maintenance

3. คลิก System

4. ในรายการ Tasks เลือก Device Manager

5. ดบัเบิลคลิก Modems

6. ดบัเบิลคลิก Agere Systems PCI-SV92PP Soft Modem

7. บนแทบ็ General ใหคลิก Diagnostics

8. คลิก Query Modem ขอความตอบกลับดวยคําวา “Success”
แสดงใหทราบวา เชื่อมตอโมเดม็แลวและโมเดม็ทํางานไดอยาง
เหมาะสม

ตาราง 2-18  การแกไขปญหาในการเชือ่มตออินเทอรเนต็ (ตอ)
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การแกไขปญหาเกีย่วกบัซอฟตแวร
ปญหาเก่ียวกับซอฟตแวรสวนใหญเกิดจากสาเหตุตอไปน้ี:

● ไมไดติดตั้งหรือตั้งคาแอปพลิเคชันอยางเหมาะสม

● หนวยความจําไมเพียงพอที่จะรันแอปพลิเคชนั

● มีขอขัดแยงระหวางแอปพลิเคชัน

● ตรวจสอบใหแนใจวา ไดติดตัง้ไดรเวอรอุปกรณทั้งหมดที่จําเปนแลว

● หากคณุไดติดตั้งระบบปฏิบัติการอ่ืนที่ไมใชระบบที่ตดิตั้งมาจากโรงงาน โปรดตรวจสอบวาระบบน้ันสามารถทํางานได
ในเคร่ืองคอมพิวเตอรของคณุ

หากคุณพบปญหาเก่ียวกับซอฟตแวร โปรดดูวิธีแกไขปญหาในตารางตอไปน้ี

ตาราง 2-19  การแกไขปญหาเกีย่วกบัซอฟตแวร

คอมพวิเตอรไมทาํงานตอ และหนาจอโลโก HP ไมปรากฏขึน้

สาเหตุ วธิแีกไข

เกดิขอผดิพลาด POST สงัเกตเสียงและไฟสถานะทีแ่ผงดานหนาของคอมพวิเตอร ดทูีภ่าคผนวก A
ขอความแสดงขอผิดพลาดของ POST ในหนา 48 เพือ่ระบุสาเหตทุี่เปน
ไปได

โปรดด ูRestore Kit หรือขอกําหนดและเงื่อนไขสําหรับการรับประกัน
แบบจํากดัทัว่โลก

คอมพวิเตอรไมทาํงานตอ หลงัจากทีห่นาจอโลโก HP ปรากฏขึน้

สาเหตุ วธิแีกไข

ไฟลระบบอาจเสียหาย ใชดิสเก็ตตสําหรับการกูคนืเพื่อตรวจหาขอผดิพลาดในฮารดไดรฟ

ขอความแสดงขอผดิพลาด “Illegal Operation has Occurred” ปรากฏขึน้

สาเหตุ วธิแีกไข

ซอฟตแวรที่ใชไมไดรับการรับรองจาก Microsoft สําหรับเวอรชนั
Windows ของคุณ

ตรวจสอบวาซอฟตแวรไดรับการรับรองจาก Microsoft สําหรับเวอรชัน
Windows ของคุณ (โปรดดขูอมูลนีบ้นหบีหอของโปรแกรม)

ไฟลตัง้คาเสียหาย หากเปนไปได บันทกึขอมูลทัง้หมด ปดโปรแกรมทัง้หมด และรีสตารท
คอมพิวเตอรของคุณ
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การตดิตอฝายบรกิารลกูคา
โปรดติดตอผูขายหรือตัวแทนจําหนายท่ีไดรับอนุญาตสําหรับคําแนะนําและบริการ คณุสามารถคนหาผูขายหรือตัวแทน
จําหนายใกลบานคุณไดที ่http://www.hp.com

หมายเหต:ุ หากคณุนําเคร่ืองคอมพิวเตอรไปรับขอบริการซอมจากผูขาย ตัวแทนจําหนาย หรือผูใหบริการที่ไดรับอนุญาต
คุณจะตองแจงรหัสผานสําหรับการตั้งคา และรหัสผานเม่ือเปดเคร่ือง ในกรณีที่คุณตั้งรหัสผานไว

ติดตอไปยงัหมายเลขโทรศพัทที่แจงไวในใบรับประกัน หรือในคูมือ หมายเลขโทรศัพทฝายสนับสนุน เพ่ือขอความชวยเหลือ
ดานเทคนิค
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A ขอความแสดงขอผิดพลาดของ POST

ภาคผนวกน้ีจะแสดงรหัสขอผดิพลาด ขอผดิพลาด ไฟแสดง และสัญญาณเสียงตางๆ ที่คุณอาจพบระหวางที่เคร่ืองทําการทด
สอบโดยอัตโนมัติเม่ือเปดเคร่ือง (Power-On Self Test - POST) หรือเม่ือเร่ิมการทํางานใหม พรอมทั้งสาเหตุที่เปนไปได
ของปญหา และขั้นตอนในการแกปญหา

ตัวเลือก POST Message Disabled จะตัดขอความสวนใหญของระบบในระหวางกระบวนการ POST เชน การนับหนวย
ความจําและขอความที่ไมใชขอผดิพลาด หากมีขอผดิพลาด POST หนาจอจะแสดงขอความแสดงขอผิดพลาด ในการเปด
โหมด POST Messages Enabled เพ่ือขอความระหวาง POST ใหกดปุมใดๆ (ยกเวน F10 หรือ F12) และโหมดที่เปน
ดีฟอลตคือ POST Message Disabled

ความเร็วที่เคร่ืองคอมพิวเตอรโหลดระบบปฏิบัติการและระดับการทดสอบจะขึ้นอยูกับการเลือกโหมด POST

Quick Boot เปนกระบวนการเริ่มตนแบบรวดเร็วซ่ึงไมรันการทดสอบในระดบัของระบบทั้งหมด เชน การทดสอบหนวย
ความจํา Full Boot จะรันการทดสอบระบบที่อาศัย ROM ทั้งหมดและใชเวลาในการทดสอบนานกวา

คุณยงัสามารถกําหนดตารางการทํา Full Boot เปนประจําทุกๆ 1 ถึง 30 วันไดดวย ในการกําหนดตารางดังกลาว ใหตั้งคาใน
ระบบคอมพิวเตอรไปเปนโหมด Full Boot Every x Days โดยใชยูทิลิตีการตั้งคาคอมพิวเตอร

หมายเหต:ุ สําหรับขอมูลเพ่ิมเติมเก่ียวกับการตั้งคาคอมพิวเตอร โปรดดูที่ คูมือยทูิลิตีการตั้งคาคอมพิวเตอร (F10)
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รหสัตวัเลขและขอความ POST
หัวขอน้ีกลาวถึงขอผิดพลาดในกระบวนการ POST ซ่ึงมีรหัสตัวเลขที่เก่ียวของ รวมถึงขอความที่อาจพบในระหวางกระบวน
การ POST

หมายเหต:ุ เคร่ืองคอมพิวเตอรจะสงสัญญาณเสียง 1 คร้ัง หลังจากที่ปรากฏขอความ POST บนหนาจอ

ตาราง A-1  รหสัตัวเลขและขอความ

ขอความทีแ่ผงควบคมุ คาํอธบิาย วธิปีฏบิตัทิีแ่นะนาํ

101-Option ROM Checksum Error การตรวจสอบผลรวม ROM ของระบบ หรือ ROM
เสริมของการดเอ็กซแพนชัน

1. ตรวจสอบวา ROM ถูกตอง

2. แฟลช ROM หากจําเปน

3. ถาเพิง่มีการเพิ่มการดเอ็กซแพนชัน ใหถอดออก
และดวูาปญหายังคงอยูหรือไม

4. ลบคาใน CMOS (โปรดดภูาคผนวก B การ
รักษาความปลอดภัยดวยรหสัผานและการรีเซ็ต
CMOS ในหนา 58)

5. หากขอความหายไป แสดงวาการดเอ็กซแพน
ชนัมีปญหา

6. เปล่ียนเมนบอรด

103-System Board Failure DMA หรือไทเมอร 1. ลบคาใน CMOS (โปรดดภูาคผนวก B การ
รักษาความปลอดภัยดวยรหสัผานและการรีเซ็ต
CMOS ในหนา 58)

2. ถอดการดเอ็กซแพนชัน

3. เปล่ียนเมนบอรด

110-Out of Memory Space for Option ROMs การดเอ็กซแพนชนัที่เพ่ิงติดตัง้มี ROM เสริมขนาด
ใหญซึง่จะตองดาวนโหลดในระหวาง POST

1. ถาเพิง่มีการเพิ่มการดเอ็กซแพนชัน PCI ให
ถอดออกและดวูาปญหายงัคงอยูหรือไม

2. ในยทูลิิตีการตัง้คาคอมพวิเตอร ใหตัง้
Advanced > Device Options > NIC
PXE Option ROM Download เปน
DISABLE เพื่อปองกนัไมให PXE option
ROM สําหรับ NIC ภายใน ถูกดาวนโหลดใน
ระหวาง POST เพื่อเพิม่หนวยความจําสําหรับ
ROM เสริมของการดเอ็กซแพนชัน PXE
option ROM ภายในใชสําหรับการบตูจาก
NIC ไปยงัเซิรฟเวอร PXE

162-System Options Not Set การตั้งคาไมถกูตอง

คุณอาจตองเปลี่ยนแบตเตอร่ีของนาฬกิาภายในระบบ
(RTC - real-time clock)

รันยทูลิิตกีารตัง้คาคอมพวิเตอร แลวตรวจสอบการ
กาํหนดคาใน Advanced > Onboard Devices

ตัง้วันทีแ่ละเวลาใหมใต Control Panel หากปญหา
ยังคงอยู ใหเปล่ียนแบตเตอรี่ RTC โปรดด ูคูมืออางอิง
เกี่ยวกบัฮารดแวร เพื่อดคูําแนะนําเกีย่วกบัการตดิตัง้
แบตเตอรี่ใหม หรือติดตอตวัแทนจําหนายหรือผูขายที่
ไดรับอนญุาตเพือ่ขอคําแนะนาํในการเปลี่ยน
แบตเตอรี่

163-Time & Date Not Set เวลาหรือวันทีใ่นหนวยความจําการตัง้คาไมถกูตอง

คุณอาจตองเปลี่ยนแบตเตอร่ีของนาฬกิาภายในระบบ
(RTC - real-time clock)

ตัง้เวลาและวันทีใ่หมที ่Control Panel (หรืออาจใช
ยูทลิิตกีารตั้งคาคอมพวิเตอร) หากปญหายังคงอยู ให
เปล่ียนแบตเตอรี่ RTC โปรดด ูคูมืออางอิงเกี่ยวกับ
ฮารดแวร เพือ่ดูคาํแนะนําเกีย่วกบัการตดิตัง้แบตเตอร่ี
ใหม หรือติดตอตวัแทนจําหนายหรือผูขายทีไ่ดรับ
อนุญาตเพือ่ขอคําแนะนาํในการเปลี่ยนแบตเตอรี่
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ขอความทีแ่ผงควบคมุ คาํอธบิาย วิธปีฏบิตัทิีแ่นะนาํ

163-Time & Date Not Set คณุอาจติดตัง้จัมเปอรของ CMOS ไมถกูตอง ตรวจสอบตาํแหนงจัมเปอรของ CMOS วาถูกตอง ถา
มี

164-MemorySize Error ปริมาณหนวยความจําเปล่ียนไป นับตัง้แตทีม่ีการบูต
คร้ังลาสุด (มกีารใสเพิม่หรือถอดหนวยความจํา)

กดปุม F1 เพื่อบันทกึการเปลี่ยนแปลงหนวยความจํา

164-MemorySize Error การตัง้คาหนวยความจําไมถกูตอง 1. รันยทูลิิตกีารตัง้คาคอมพิวเตอรหรือยูทิลิตขีอง
Windows

2. โปรดตรวจสอบวามีการตดิตัง้โมดลูหนวยความ
จําอยางถกูตอง

3. หากมีการใชหนวยความจําของผูผลิตรายอื่น
โปรดทดสอบโดยใชเฉพาะหนวยความจําเฉพาะ
ของ HP

4. ตรวจสอบวาประเภทโมดลูหนวยความจําถกูตอง

201-Memory Error RAM ลมเหลว 1. ตรวจสอบวาโมดูลหนวยความจําไดรับการติด
ตั้งอยางถกูตอง

2. ตรวจสอบวาประเภทโมดลูหนวยความจําถกูตอง

3. ถอดและเปลี่ยนโมดูลหนวยความจําทีถ่กูระบุวา
บกพรอง

4. หากขอผดิพลาดยงัคงอยูหลังจากเปลี่ยนหนวย
ความจําแลว ใหเปล่ียนเมนบอรด

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

โมดูลหนวยความจําในซ็อกเกต็หนวยความจําทีร่ะบุใน
ขอความแสดงขอผดิพลาดขาดขอมูล SPD หรือเขา
กับชปิเซ็ตไมได

1. ตรวจสอบวาประเภทโมดลูหนวยความจําถกูตอง

2. ลองใชซ็อกเกต็หนวยความจําอื่น

3. เปล่ียน DIMM โดยใชโมดลูที่เขากนักบั
มาตรฐาน SPD

214-DIMM Configuration Warning การกําหนดคา DIMM ทีต่ิดตั้ง ไมเหมาะสม จัดเรียง DIMM ใหมเพื่อใหแตละแชนเนลมีจํานวน
หนวยความจําเทานั้น

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

โมดูลหนวยความจําทีเ่พิ่งตดิตัง้สนับสนนุการแกไขขอ
ผดิพลาดของหนวยความจํา ECC

1. ถาเพิง่มีการเพิ่มหนวยความจํา ใหถอดออกและ
ดูวาปญหายงัคงอยูหรือไม

2. ตรวจสอบเอกสารทีม่าพรอมกับผลิตภัณฑ เพือ่ดู
ขอมูลเกีย่วกบัการสนบัสนนุหนวยความจํา

301-Keyboard Error แปนพิมพไมทํางาน 1. ตอแปนพมิพเขากบัคอมพวิเตอรใหมอีกคร้ังใน
ขณะปดเคร่ือง

2. ตรวจสอบวาชองเสียบมีการหกังอหรือสูญหาย
หรือไม

3. ตรวจดวูาไมมกีารกดแปนอักษรใดๆ

4. เปล่ียนแปนพิมพ

303-Keyboard Controller Error คอนโทรลเลอรแปนพมิพของบอรด I/O 1. ตอแปนพมิพเขากบัคอมพวิเตอรใหมอีกคร้ังใน
ขณะปดเคร่ือง

2. เปล่ียนเมนบอรด

304-Keyboard or System Unit Error แปนพิมพไมทํางาน 1. ตอแปนพมิพเขากบัคอมพวิเตอรใหมอีกคร้ังใน
ขณะปดเคร่ือง

2. ตรวจดวูาไมมกีารกดแปนอักษรใดๆ
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3. เปล่ียนแปนพิมพ

4. เปล่ียนเมนบอรด

501-Display Adapter Failure คอนโทรลเลอรจอภาพกราฟก 1. ตอการดแสดงผลใหม (ถามี)

2. ลบคาใน CMOS (โปรดดภูาคผนวก B การ
รักษาความปลอดภัยดวยรหสัผานและการรีเซ็ต
CMOS ในหนา 58)

3. ตรวจสอบวาตอและเปดหนาจอแลว

4. เปล่ียนการดแสดงผล (ถาเปนไปได)

510-Splash Screen Image Corrupted อิมเมจของ Flash Screen มีขอผิดพลาด แฟลช ROM ของระบบอีกคร้ัง ดวยอิมเมจลาสุดของ
BIOS

511-CPU, CPUA, or CPUB Fan not Detected พัดลม CPU ไมถูกเชือ่มตอหรืออาจทํางานผิดพลาด 1. ตดิตัง้พัดลม CPU ใหมอีกคร้ัง

2. ตดิตั้งสายเคเบิลสําหรับพัดลมใหมอกีคร้ัง

3. เปล่ียนพัดลม CPU

512-Chassis, Rear Chassis, or Front Chassis
Fan not Detected

พัดลมทีต่วัโครง ตัวโครงดานหลัง หรือตัวโครงดาน
หนา ไมไดถกูเชือ่มตอ หรืออาจทํางานไมถกูตอง

1. พัดลมทีต่ัวโครง ตัวโครงดานหลัง หรือตัวโครง
ดานหนาใหมอีกคร้ัง

2. ตดิตั้งสายเคเบิลสําหรับพัดลมใหมอกีคร้ัง

3. เปล่ียนพัดลมทีต่ัวโครง ตวัโครงดานหลัง หรือตัว
โครงดานหนา

514-CPU or Chassis Fan not Detected พัดลม CPU หรือพดัลมทีต่ัวโครงไมถกูเชือ่มตอหรือ
อาจทาํงานผดิพลาด

1. ตดิตัง้พัดลม CPU หรือพดัลมทีต่ัวโครงใหมอีก
คร้ัง

2. ตดิตั้งสายเคเบิลสําหรับพัดลมใหมอกีคร้ัง

3. เปล่ียนพัดลม CPU หรือพัดลมที่ตวัโครง

601-Diskette Controller Error วงจรคอนโทรลเลอรดสิเกต็ตหรือวงจรฟลอปป
ไดรฟไมถกูตอง

1. ตรวจสอบและ/หรือเปล่ียนสายเคเบิล

2. ลบคาใน CMOS (โปรดดภูาคผนวก B การ
รักษาความปลอดภัยดวยรหสัผานและการรีเซ็ต
CMOS ในหนา 58)

3. เปล่ียนดิสเกต็ตไดรฟ

4. เปล่ียนเมนบอรด

605-Diskette Drive Type Error ประเภทของไดรฟไมตรงกนั 1. ถอดอุปกรณคอนโทรลเลอรของดสิเกต็ตอื่นๆ
ทั้งหมด (เทปไดรฟ)

2. ลบคาใน CMOS (โปรดดภูาคผนวก B การ
รักษาความปลอดภัยดวยรหสัผานและการรีเซ็ต
CMOS ในหนา 58)

660-Display cache is detected unreliable แคชแสดงผลของคอนโทรลเลอรกราฟกทํางานไมถูก
ตองและจะถกูปดลง

เปล่ียนเมนบอรดหากการดอยลงของกราฟกอยูในขั้น
ต่าํ

912-Computer Cover Has Been Removed
Since Last System Startup

ฝาครอบคอมพวิเตอรถกูถอดออกตั้งแตการเริ่มตน
ระบบครั้งทีแ่ลว

ไมตองดาํเนินการใดๆ

917-Front Audio Not Connected ตัวควบคมุเสียงดานหนาไมไดเชือ่มตอหรือตดิตัง้เขา
กับเมนบอรด

เชื่อมตอหรือเปล่ียนตัวควบคมุเสียงดานหนา
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918-Front USB Not Connected ตัวควบคุม USB ดานหนาไมไดเชือ่มตอหรือติดตั้งเขา
กับเมนบอรด

เชื่อมตอหรือเปล่ียนตวัควบคมุ USB ดานหนา

921-Device in PCI Express slot failed to
initialize

สวนนีเ้ปนปญหา/ความไมสามารถเขากนัไดกบั
อุปกรณนี้ และระบบหรือ PCI Express Link ไม
สามารถเรียนรูทํางานที ่x1

ลองบูตเคร่ืองอีกคร้ัง หากขอผิดพลาดยงัเกดิขึ้นซ้ํา
อุปกรณนี้อาจไมสามารถทาํงานกบัระบบนี้

1151-Serial PortA Address Conflict Detected พอรตอนกุรมทัง้ภายในและภายนอกกาํหนดไวที่
COM1

1. ถอดการดเอ็กซแพนชันของพอรตอนกุรมทั้ง
หมด

2. ลบคาใน CMOS (โปรดดภูาคผนวก B การ
รักษาความปลอดภยัดวยรหสัผานและการรีเซ็ต
CMOS ในหนา 58)

3. ตั้งคาการดเอ็กซแพนชันใหมและ/หรือรันยทูิลิตี
การตัง้คาคอมพวิเตอรหรือยูทลิิตีของ
Windows

1152-Serial Port B Address Conflict Detected พอรตอนุกรมทัง้ภายในและภายนอกถกูกําหนดไวที่
COM2

1. ถอดการดเอ็กซแพนชันของพอรตอนกุรมทั้ง
หมด

2. ลบคาใน CMOS (โปรดดภูาคผนวก B การ
รักษาความปลอดภยัดวยรหสัผานและการรีเซ็ต
CMOS ในหนา 58)

3. ตั้งคาการดเอ็กซแพนชันใหมและ/หรือรันยทูิลิตี
การตัง้คาคอมพวิเตอรหรือยูทลิิตีของ
Windows

1155-Serial Port Address Conflict Detected พอรตอนุกรมทัง้ภายในและภายนอกถกูกําหนดไวที่
IRQ เดียวกัน

1. ถอดการดเอ็กซแพนชันของพอรตอนกุรมทั้ง
หมด

2. ลบคาใน CMOS (โปรดดภูาคผนวก B การ
รักษาความปลอดภยัดวยรหสัผานและการรีเซ็ต
CMOS ในหนา 58)

3. ตั้งคาการดเอ็กซแพนชันใหมและ/หรือรันยทูิลิตี
การตัง้คาคอมพวิเตอรหรือยูทลิิตีของ
Windows

1720-SMART Hard Drive detects imminent
failure

ฮารดไดรฟกาํลังจะหยุดทํางาน (ฮารดไดรฟบางตวัมี
เฟรมแวรแพตชทีจ่ะแกไขขอความแสดงขอผดิพลาด
ทีไ่มถกูตอง)

1. ตรวจสอบวาฮารดไดรฟใหขอความแสดงขอผิด
พลาดทีถู่กตอง เขาสูยูทลิิตีการตัง้คา
คอมพวิเตอร แลวรันโปรแกรมการทดสอบ
ระบบปองกนัไดรฟใต Storage > DPS Self-
test

2. ใชเฟรมแวรแพตช หากมี (เลือกใชไดจาก
http://www.hp.com/support)

3. ทําขอมูลสํารองแลวเปล่ียนฮารดไดรฟ

1796-SATA Cabling Error อุปกรณ SATA ไมไดรับการเชื่อมตออยางเหมาะสม
เพื่อประสิทธิภาพการทํางานสูงสุด จะตองใชชองเสียบ
SATA 0 และ SATA 1 กอน SATA 2 และ SATA
3

ตรวจสอบใหแนใจวามกีารใชชองเสียบ SATA ตาม
ลําดบัที่ถกูตอง สําหรับอุปกรณเดียว ใหใช SATA 0
สําหรับสองอุปกรณ ใหใช SATA 0 และ SATA 1
สําหรับสามอุปกรณ ใหใช SATA 0, SATA 1 และ
SATA 2

1797-SATA Drivelock is not supported in
RAID mode

Drivelock ถูกเปดใชบนฮารดไดรฟ SATA หนึง่หรือ
หลายตัว และไมสามารถเขาถงึไดในขณะทีก่ําลัง
กําหนดคาระบบสําหรับโหมด RAID

ถอดอุปกรณ Drivelocked SATA ออกกอนหรือปด
การทํางานของคุณสมบัต ิDrivelock ในการปดการทํา
งานของคุณสมบัต ิDrivelock ใหเขาสูยูทลิิตีการตัง้คา
คอมพวิเตอร เปล่ียน Storage > Storage
Options > SATA Emulation เปน IDE และ
เลือก File > Save Changes and Exit เขาสูยทูลิิ
ตีการตัง้คาคอมพวิเตอรอีกคร้ัง และเลือก Security >
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Drivelock Security สําหรับอุปกรณ SATA ทีใ่ช
Drivelock ไดแตละอุปกรณ ดใูหแนใจวาไดตั้ง
Drivelock เปน Disabled สุดทาย ใหเปล่ียน
Storage > Storage Options > SATA
Emulation กลับเปน RAID และเลือก File > Save
Changes and Exit

1801-Microcode Patch Error ROM BIOS ไมสนบัสนนุโปรเซสเซอร 1. อัพเกรด BIOS ใหเปนเวอรชนัทีเ่หมาะสม

2. เปล่ียนโปรเซสเซอร

2200-PMM Allocation Error during MEBx
Download

เกดิขอผิดพลาดทีห่นวยความจําในขณะดาํเนนิการ
POST ของ Management Engine (ME) BIOS
Extensions option ROM

1. รีบูตคอมพวิเตอร

2. ถอดปลั๊กคอมพวิเตอร ถอดและตอโมดลูหนวย
ความจําอีกคร้ัง กอนรีบูตคอมพิวเตอร

3. หากคุณเพ่ิงเปล่ียนแปลงการกําหนดคาหนวย
ความจํา ใหถอดปล๊ักคอมพวิเตอร เรียกคืนการ
กาํหนดคาหนวยความจําดั้งเดิม และรีบูต
คอมพวิเตอร

4. หากปญหายงัคงอยู ใหเปล่ียนเมนบอรด

2201-MEBx Module did not checksum
correctly

เกดิขอผิดพลาดทีห่นวยความจําในขณะดาํเนนิการ
POST ของ Management Engine (ME) BIOS
Extensions option ROM

1. รีบูตคอมพวิเตอร

2. ถอดปลั๊กคอมพวิเตอร ถอดและตอโมดลูหนวย
ความจําอีกคร้ัง กอนรีบูตคอมพิวเตอร

3. หากคุณเพ่ิงเปล่ียนแปลงการกําหนดคาหนวย
ความจํา ใหถอดสายไฟ เรียกคืนการกําหนดคา
หนวยความจําดั้งเดิม และรีบูตคอมพิวเตอร

4. หากปญหายงัคงอยู ใหเปล่ียนเมนบอรด

2202-PMM Deallocation Error during MEBx
cleanup

เกดิขอผิดพลาดทีห่นวยความจําในขณะดาํเนนิการ
POST ของ Management Engine (ME) BIOS
Extensions option ROM

1. รีบูตคอมพวิเตอร

2. ถอดปลั๊กคอมพวิเตอร ถอดและตอโมดลูหนวย
ความจําอีกคร้ัง กอนรีบูตคอมพิวเตอร

3. หากคุณเพ่ิงเปล่ียนแปลงการกําหนดคาหนวย
ความจํา ใหถอดสายไฟ เรียกคืนการกําหนดคา
หนวยความจําดั้งเดิม และรีบูตคอมพิวเตอร

4. หากปญหายงัคงอยู ใหเปล่ียนเมนบอรด

2203-Setup error during MEBx execution การเลือกหรือการออกจาก MEBx ทําใหตั้งคาไม
สําเร็จ

1. รีบูตคอมพวิเตอร

2. ถอดปลั๊กคอมพวิเตอร ถอดและตอโมดลูหนวย
ความจําอีกคร้ัง กอนรีบูตคอมพิวเตอร

3. หากคุณเพ่ิงเปล่ียนแปลงการกําหนดคาหนวย
ความจํา ใหถอดสายไฟ เรียกคืนการกําหนดคา
หนวยความจําดั้งเดิม และรีบูตคอมพิวเตอร

4. หากปญหายงัคงอยู ใหเปล่ียนเมนบอรด

2204-Inventory error during MEBx execution ขอมูล BIOS ทีส่งผานไปใหกบั MEBx สงผลใหเกดิ
ขอผดิพลาด

1. รีบูตคอมพวิเตอร

2. หากปญหายงัคงอยู ใหอัพเดต BIOS เปน
เวอรชนัลาสุด

3. หากปญหายงัคงอยู ใหเปล่ียนเมนบอรด
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2205-Interface error during MEBx execution การดําเนนิการ MEBx ทําใหเกดิขอผดิพลาดที่
ฮารดแวรในขณะทีส่ื่อสารกบั ME

1. รีบูตคอมพวิเตอร

2. หากปญหายงัคงอยู ใหอัพเดต BIOS เปน
เวอรชนัลาสุด

3. หากปญหายงัคงอยู ใหเปล่ียนเมนบอรด

ไมไดกําหนดคา 2211-Memory อยางถกูตองสําหรับ
การดําเนนิการ MEBx อยางเหมาะสม

ไมไดติดตั้ง DIMM1 ตรวจดใูหแนใจวามีโมดูลหนวยความจําในซ็อคเกต็
DIMM1 สีดําและดนัอยูในตําแหนงทีถ่กูตอง

Invalid Electronic Serial Number. อิเล็กทรอนิกสซีเรียลนมัเบอรหาย ปอนซีเรียลนมัเบอรทีถู่กตองลงใน Computer Setup

Network Server Mode Active and No
Keyboard Attached

แปนพิมพไมทํางานในขณะที่เปดใชงาน Network
Server Mode

1. ตอแปนพมิพเขากบัคอมพวิเตอรใหมอีกคร้ังใน
ขณะปดเคร่ือง

2. ตรวจสอบวาชองเสียบมีการหกังอหรือสูญหาย
หรือไม

3. ตรวจดวูาไมมกีารกดแปนอักษรใดๆ

4. เปล่ียนแปนพิมพ

Parity Check 2. Parity RAM ไมทํางาน รันยทูลิิตกีารตัง้คาคอมพิวเตอรและยทูลิิตีการวินจิฉยั

ตาราง A-1  รหสัตัวเลขและขอความ (ตอ)
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การแปลความหมายของสญัญาณไฟวนิจิฉยัการ POST ทีแ่ผงดานหนาและ
รหสัเสยีง

หัวขอน้ีกลาวถึงรหัสสัญญาณไฟที่แผงดานหนารวมทั้งรหัสเสียงที่อาจเกิดขึ้นกอนหรือระหวางกระบวนการ POST ซ่ึงไมจํา
เปนตองมีรหัสหมายเลขหรือขอความแสดงขอผิดพลาดเขามาเก่ียวของ

คาํเตอืน! เม่ือตอสายไฟกับเคร่ืองคอมพิวเตอร แหลงจายไฟจะมีแรงดนัไฟฟาสําหรับเมนบอรดอยูตลอดเวลา เพ่ือลดความ
เส่ียงที่จะไดรับบาดเจ็บจากไฟฟาช็อต และ/หรือพ้ืนผิวที่รอน คุณควรตรวจดูใหแนใจวา ไดถอดปล๊ักไฟแลว และปลอยใหสวน
ประกอบภายในของระบบเย็นกอนจะสัมผสั

หมายเหต:ุ หากไฟที่แปนพิมพ PS/2 กะพริบ ใหตรวจดูไฟกะพริบบนแผงดานหนาของคอมพิวเตอร และดูรายละเอียดใน
ตารางดานลางน้ีเพ่ือระบุรหัสสัญญาณไฟที่แผงดานหนา

ควรปฏิบัติตามการดําเนินการที่แนะนําในตารางดานลางน้ี

ไฟสัญญาณวินิจฉัยและรหัสเสียงไมไดมีอยูในทุกรุน

ตาราง A-2  สัญญาณไฟทีแ่ผงดานหนาและรหสัเสียง

การทาํงาน สญัญาณเสยีง สาเหตทุีเ่ปนไปได การดาํเนนิการทีแ่นะนาํ

ไฟสถานะเปดเคร่ืองสีเขยีวสวาง ไมมี เคร่ืองคอมพิวเตอรเปดอยู ไมมี

ไฟสถานะเปดเคร่ืองสีเขยีวกะพริบ
ทกุ 2 วินาที

ไมมี คอมพวิเตอรอยูในโหมดพักการ
ทํางานของ RAM (บางรุนเทา
นัน้) หรือโหมดพกัการทาํงาน
ปกติ

ไมจําเปน กดปุมใดๆ หรือขยบัเมาส เพื่อใหคอมพิวเตอรทํา
งานอีกคร้ัง

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ 2
คร้ังทกุๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเนื่อง
คร้ังที ่5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

2 ระบบปองกนัความรอนของ
โปรเซสเซอรถกูเปดใชงาน:

พัดลมอาจถูกปดกั้นหรือไมทาํ
งาน

หรือ

ตวัระบายความรอน/พัดลมไม
ไดเชื่อมตอกับโปรเซสเซอร
อยางถกูตอง

1. ตรวจสอบวาชองระบายอากาศไมไดถกูปดกั้นและพัด
ลมระบายความรอนทํางาน

2. เปดฝาครอบ กดปุมเพาเวอร แลวดูวาพดัลมที่
โปรเซสเซอรหมุนหรือไม หากพดัลมที่โปรเซสเซอร
ไมหมุน ใหตรวจดวูา ไดเสียบสายเคเบิลของพดัลมเขา
กบัเฮดเดอรบนเมนบอรดเรียบรอยแลวใชหรือไม

3. หากพัดลมถกูตออยูแลวแตไมหมุน ใหเปล่ียนชิ้นสวน
ตวัระบายความรอน/พดัลม

4. ตดิตอผูใหบริการหรือตัวแทนจําหนายทีไ่ดรับอนญุาต

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ 3
คร้ังทกุๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเนื่อง
คร้ังที ่5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

3 ไมไดตดิตัง้โปรเซสเซอร (ไมได
บงชีว้าโปรเซสเซอรบกพรอง)

1. ตรวจดวูามีโปรเซสเซอรอยูในเคร่ืองหรือไม

2. ตดิตัง้โปรเซสเซอรอีกคร้ัง

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ 4
คร้ังทกุๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเนื่อง
คร้ังที ่5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

4 แหลงจายไฟไมทํางาน (แหลง
จายไฟโอเวอรโหลด)

หรือ

อะแดปเตอรแหลงจายไฟภาย
นอกทีไ่มถกูตองกําลังถูกใชงา
นอยุบน USDT

1. เปดฝาครอบ แลวตรวจดวูาสายเคเบิลของแหลงจาย
ไฟแบบ 4 หรือ 6 สาย เชือ่มตอเขากบัชองเสียบบน
เมนบอรดแลว

2. ตรวจสอบวาอุปกรณเปนสาเหตุใหเกดิปญหานีห้รือไม
โดยถอดอุปกรณทั้งหมดทีเ่ชื่อมตออยู (เชน
ฮารดไดรฟ ดสิเก็ตตไดรฟ หรือไดรฟออปตคิัล และ
การดเอ็กซแพนชนั) เปดเคร่ืองคอมพิวเตอร หาก
คอมพิวเตอรเขาสู POST ใหปดเคร่ือง แลวตอ
อุปกรณกลับคนืคร้ังละชิ้น และทําตามขัน้ตอนดังกลาว
ซ้ําอีกคร้ังจนกวาเคร่ืองจะไมทํางาน เปล่ียนอุปกรณที่
เปนสาเหตุใหเคร่ืองไมทํางาน ตออุปกรณกลับคืนคร้ัง
ละชิ้น เพื่อใหแนใจวาอุปกรณทัง้หมดทํางานเปนปกติ

3. เปล่ียนแหลงจายไฟ

4. เปล่ียนเมนบอรด

THWW การแปลความหมายของสัญญาณไฟวินิจฉัยการ POST ที่แผงดานหนาและรหัสเสียง 55



การทาํงาน สญัญาณเสยีง สาเหตทุีเ่ปนไปได การดาํเนนิการทีแ่นะนาํ

หรือ

อะแดปเตอรแหลงจายไฟ USDT ตองอยูที่ 135 วัตตและใช
เทคโนโลย ีSmart ID กอนทีร่ะบบจะเริ่มทํางาน เปล่ียน
อะแดปเตอรแหลงจายไฟดวยอะแดปเตอรแหลงจายไฟ
USDT ของ HP

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ 5
คร้ังทกุๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเนื่อง
คร้ังที ่5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

5 หนวยความจําการแสดงผลเกดิ
ขอผดิพลาด

ขอควรระวงั: ในการหลีกเล่ียงความเสียหายของ DIMM
หรือเมนบอรด คณุตองถอดปลั๊กคอมพวิเตอรกอนทีจ่ะ
พยายามตอ ตดิตัง้ หรือนําโมดูล DIMM ออก

1. ใส DIMM ใหมอีกคร้ัง

2. เปล่ียน DIMM ทลีะชิน้ เพื่อแยกโมดลูที่มีขอผิดพลาด
ออก

3. ใชหนวยความจําของ HP แทนหนวยความจําของผู
ผลิตรายอื่น

4. เปล่ียนเมนบอรด

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ 6
คร้ังทกุๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเนื่อง
คร้ังที ่5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

6 การแสดงผลมีขอผดิพลาด สําหรับระบบทีใ่ชการดแสดงผล:

1. ตดิตั้งการดแสดงผลใหม

2. เปล่ียนการดแสดงผล

3. เปล่ียนเมนบอรด

สําหรับระบบทีใ่ชกราฟกภายใน ใหเปล่ียนเมนบอรด

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ 7
คร้ังทกุๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเนื่อง
คร้ังที ่5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

7 เมนบอรดขัดของ (ROM ตรวจ
พบการขัดของกอนการแสดง
ผล).

เปล่ียนเมนบอรด

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ 8
คร้ังทกุๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเนื่อง
คร้ังที ่5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

8 ROM ไมถกูตอง เนือ่งจากการ
ตรวจสอบผลรวมผดิพลาด

1. แฟลช ROM ของระบบอีกคร้ัง ดวยอิมเมจลาสุดของ
BIOS โปรดดูรายละเอียดเพิม่เติมในหวัขอ โหมดกู
คนืฉุกเฉินบล็อคการบูต” ใน คูมือการจัดการ
เดสกทอป

2. เปล่ียนเมนบอรด

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ 9
คร้ังทกุๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเนื่อง
คร้ังที ่5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

9 เคร่ืองเปดอยู แตไมสามารถบูต
ระบบ

1. ตรวจสอบสวิตชเลือกระดับแรงดันไฟฟาทีด่านหลัง
ของแหลงจายไฟ (ในคอมพิวเตอรบางรุน) วาอยูใน
ตาํแหนงของระดบัแรงดนัไฟฟาที่ถกูตอง การตั้งคา
แรงดันไฟฟาที่เหมาะสมขึน้อยูกบัประเทศ/พืน้ที่ทีคุ่ณ
อาศยัอยู

2. ถอดปลั๊กสายไฟ AC ออกจากคอมพิวเตอร รอ
30 วินาท ีและเสียบปล๊ักสายไฟเขากบัคอมพิวเตอรอีก
คร้ัง

3. เปล่ียนเมนบอรด

4. เปล่ียนโปรเซสเซอร

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ 10
คร้ังทกุๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเนื่อง
คร้ังที ่5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

10 การดเสริมมีขอบกพรอง 1. ตรวจสอบการดเสริมแตละชิ้น โดยถอดการดออกทลีะ
ชิน้ (ในกรณีทีต่ดิตัง้การดหลายชิน้) จากนัน้ใหเปด
เคร่ือง เพือ่ดูวายังมีขอบกพรองหรือไม

2. ถาพบการดทีผ่ิดปกต ิใหถอดออกและเปลี่ยนอันใหม

3. เปล่ียนเมนบอรด

ตาราง A-2  สญัญาณไฟที่แผงดานหนาและรหสัเสียง (ตอ)
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การทาํงาน สญัญาณเสยีง สาเหตทุีเ่ปนไปได การดาํเนนิการทีแ่นะนาํ

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ
แปดคร้ังทกุๆ วินาท ีจากนัน้เวนสอง
วินาท ีเสียงเตอืนหยดุหลังจากดงัตอ
เนือ่งคร้ังที ่5 แตไฟ LED จะสวางจน
กวาปญหาจะไดรับการแกไข

11 โปรเซสเซอรปจจุบันไมรองรับ
คณุสมบัตทิี่ใชงานกอนหนานี้
บนระบบนี้

1. ตดิตัง้โปรเซสเซอร TXT เทาที่ตองการ

2. ยกเลิกใชงาน TXT ในยูทลิิตีการตัง้คา
คอมพิวเตอร (F10)

3. ตดิตัง้โปรเซสเซอรเดมิซ้ํา

ไมสามารถเปดเคร่ืองคอมพวิเตอร
และไฟแสดงสถานะทีแ่ผงดานหนา
ของคอมพิวเตอรไมกะพริบ

ไมมี ไมสามารถเริ่มตนการทํางาน
ของระบบ

กดปุมเพาเวอรคางไวไมถึง 4 วินาท ีหากไฟสถานะ
ฮารดไดรฟเปล่ียนเปนสีเขียว แสดงวาปุมเพาเวอรทํางาน
เปนปกติ ใหปฏิบัตติามขั้นตอนตอไปนี:้

1. ตรวจสอบสวิตชเลือกระดับแรงดันไฟฟา (ในบางรุน)
ทีด่านหลังของแหลงจายไฟวาอยูในตําแหนงของ
ระดับแรงดนัไฟฟาที่ถกูตอง การตัง้คาแรงดันไฟฟาที่
เหมาะสมขึน้อยูกบัประเทศ/พืน้ทีท่ีคุ่ณอาศยัอยู

2. เปล่ียนเมนบอรด

หรือ

กดปุมเพาเวอรคางไวไมถึง 4 วินาท ีหากไฟสถานะ
ฮารดไดรฟไมเปล่ียนเปนสีเขยีว ใหปฏิบัตดิังนี:้

1. ตรวจดูวาอุปกรณเสียบปล๊ักเขากบัเตารับไฟฟาอยาง
ถกูตอง

2. เปดฝาครอบ แลวตรวจดวูาตวัควบคุมปุม
เพาเวอรเชือ่ม
ตอเขากบัเมนบอรดอยางถกูตอง

3. ตรวจดวูาสายแหลงจายไฟทัง้ 2 สายเชื่อมตอเขากบั
เมนบอรดอยางถกูตอง

4. ตรวจดูวาไฟ 5V_aux บนเมนบอรดสวางหรือไม ถา
ไฟสวาง ใหเปล่ียนตวัควบคมุปุมเพาเวอร หากปญหา
ยงัคงอยู ใหเปล่ียนเมนบอรด

5. ถาไฟ 5V_aux บนเมนบอรดดับ ใหถอดการดเอ็กซ
แพนชันออกทลีะการดจนกวาไฟ 5V_aux บน
เมนบอรดจะสวาง หากปญหายงัคงอยู ใหเปล่ียนแหลง
จายไฟ

ตาราง A-2  สัญญาณไฟทีแ่ผงดานหนาและรหสัเสียง (ตอ)
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B การรกัษาความปลอดภยัดวยรหสัผานและการรเีซต็
CMOS

คอมพิวเตอรน้ีรองรับการใชคุณสมบัติรักษาความปลอดภัยดวยรหัสผาน ซ่ึงสามารถกําหนดไดในเมนูของ ยทูิลิตีการตั้งคา
คอมพิวเตอร

คอมพิวเตอรน้ีรองรับการใชคุณสมบัติรักษาความปลอดภัยดวยรหัสผานสองคุณสมบัต ิซ่ึงสามารถกําหนดไดในเมนูของ
ยูทิลิตีการตั้งคาคอมพิวเตอร รหัสผานสําหรับการตั้งคา และรหัสผานเม่ือเปดเคร่ือง หากคณุกําหนดเฉพาะ รหัสผานสําหรับ
การตั้งคา ผูใชทุกรายจะสามารถเขาถึงขอมูลทั้งหมดในระบบ ยกเวนการกําหนดคาในยทูิลิตีการตั้งคาคอมพิวเตอร และหาก
คุณใชเฉพาะรหัสผานเม่ือเปดเคร่ือง ผูใชจะตองปอนรหัสผานเพ่ือเขาใชยูทิลิตีการตั้งคาคอมพิวเตอร หากคุณกําหนดรหัส
ผานทั้งสองชนิดไว จะมีเพียงรหัสผานสําหรับการตั้งคาเทาน้ันที่ใชในการเขาสูยทูิลิตีการตั้งคาคอมพิวเตอรได

หากคุณกําหนดรหัสผานทั้งสองชนิด รหัสผานสําหรับการตัง้คาจะใชแทนรหัสผานเม่ือเปดเคร่ืองในการล็อกเขาสูระบบได
คุณสมบัติดงักลาวถือวาเปนประโยชนสําหรับผูดแูลระบบ

หากคุณลืมรหัสผานสําหรับคอมพิวเตอรของคุณ คุณสามารถยกเลิกรหัสผานเพ่ือใหคุณสามารถเขาใชขอมูลบนคอมพิวเตอร
โดยการรีเซ็ตจัมเปอรรหัสผาน

ขอควรระวัง: การสํารองขอมูลทําไดโดยเขาสูยทูิลิตีการตั้งคาคอมพิวเตอร ส่ิงสําคญัคือการสํารองขอมูลใน CMOS ของ
คอมพิวเตอรกอนที่จะรีเซ็ต ในกรณีที่อาจตองการใชในภายหลัง การสํารองขอมูลทําไดโดยเขาสูยทูิลิตกีารตั้งคาคอมพิวเตอร
โปรดดูรายละเอียดเก่ียวกับการสํารองขอมูล CMOS ใน คูมือยทูิลิตกีารตั้งคาคอมพิวเตอร (F10)
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การรเีซต็จมัเปอรรหสัผาน
ในการตัดการทํางานของรหัสผานเม่ือเปดเคร่ืองหรือรหัสผานสําหรับการตั้งคา ใหปฏิบัติตามขั้นตอนตอไปน้ี:

1. ปดระบบปฏิบัติการตามขัน้ตอนที่ถูกตอง จากน้ันปดเคร่ืองคอมพิวเตอรและอุปกรณภายนอกอ่ืนๆ ถอดสายไฟออกจาก
เตารับไฟฟา

2. เม่ือถอดสายไฟแลว ใหกดปุมเพาเวอรอีกคร้ังเพื่อถายกระแสไฟที่ยังหลงเหลืออยูในคอมพิวเตอร

คาํเตอืน! เพ่ือลดความเส่ียงตอการบาดเจ็บจากไฟฟาช็อตและ/หรือพ้ืนผิวที่รอน ควรถอดสายไฟออกจากเตารับที่
ผนัง และใหสวนประกอบภายในของเครื่องคอมพิวเตอรเยน็ลงกอนที่จะสัมผัส

ขอควรระวงั: เม่ือตอสายไฟกับเคร่ืองคอมพิวเตอร แหลงจายไฟจะมีแรงดนัไฟฟาสําหรับเมนบอรดอยูตลอดเวลา แม
วาเคร่ืองจะปดอยูก็ตาม หากคุณไมถอดสายไฟออก อาจเกิดความเสียหายแกระบบได

ไฟฟาสถิตอาจทําใหสวนประกอบอิเล็กทรอนิกสของคอมพิวเตอรหรือการดเสริมชํารุดเสียหายได กอนที่จะเร่ิมตน
กระบวนการเหลาน้ี โปรดตรวจสอบวาคุณไดคายประจุไฟฟาสถิตดวยการสัมผัสวัตถุที่เปนโลหะและมีการลงกราวด
โปรดดคููมือ ขอมูลเก่ียวกับความปลอดภัยและขอบังคับตางๆ เพ่ิมเตมิ

3. ถอดฝาครอบคอมพิวเตอรหรือแผงดานขาง

4. หาตําแหนงเฮดเดอรและจัมเปอร

หมายเหต:ุ จัมเปอรรหัสผานจะเปนสีเขียว ทําใหระบุไดงาย หากตองการคําแนะนําในการหาตําแหนงของจัมเปอร
รหัสผานและสวนประกอบอ่ืนๆ ของเมนบอรด โปรดดูที่แผนผังชิ้นสวนและบริการพรอมภาพประกอบ (IPSM) สําหรับ
ระบบของคุณ โดยคณุสามารถดาวนโหลด IPSM ไดจาก http://www.hp.com/support

5. ถอดจัมเปอรออกจาก pin 1 และ 2 แลววางจัมเปอรที่ pin 1 หรือ 2 แตอยาวางที่ทั้งคู ทั้งน้ีเพ่ือปองกันการสูญหาย

6. เปล่ียนฝาครอบคอมพิวเตอรหรือแผงปดเคร่ืองคอมพิวเตอร

7. ตออุปกรณภายนอก

8. เสียบปล๊ักและเปดเคร่ืองคอมพิวเตอร ใหระบบปฏิบัตกิารเร่ิมทํางาน วิธีน้ีเปนการยกเลิกรหัสผานปจจุบันและเลิกใชงาน
คณุสมบัติรหัสผาน

9. เพ่ือที่จะตัง้รหัสผานใหม ใหทําซํ้าขัน้ตอน 1 ถึง 4 เปล่ียนจัมเปอรรหัสผานบน pin 1 และ 2 จากน้ันใหทําซํ้า 6 ถึง 8
แลวตั้งรหัสผานใหมในการตัง้คาคอมพิวเตอร ดูที่ คูมือยูทิลิตีการตั้งคาคอมพิวเตอร (F10) สําหรับขอมูลเพ่ิมเติมเก่ียว
กับการใชโปรแกรมการตั้งคาคอมพิวเตอร
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การลบคาและการรเีซต็ CMOS
หนวยความจําการตัง้คาของคอมพิวเตอร (CMOS) เปนที่เก็บขอมูลเก่ียวกับการตัง้คาคอมพิวเตอร

ปุม CMOS จะรีซ็ตแตไมไดลบรหัสผานปองกันการเปดเคร่ืองและรหัสผานสําหรับการตั้งคา

การลบคาใน CMOS จะลบคาการตั้งคา Active Management Technology (AMT) ใน Management Engine BIOS
Extension (MEBx) รวมทั้งรหัสผาน รหัสผานจะเปลี่ยนคาเร่ิมตนเปน “admin” และจําเปนตองรีเซ็ต การตั้งคา AMT ยัง
ตองรีเซ็ตดวย ในการเขาใช MEBx ใหกด Ctrl+P ระหวาง POST

1. ปดเคร่ืองคอมพิวเตอรและอุปกรณภายนอกทั้งหมด แลวถอดสายไฟออกจากเตารับไฟฟา

2. ถอดสายแปนพิมพ จอภาพ และอุปกรณภายนอกอ่ืนๆ ออกจากคอมพิวเตอร

คาํเตอืน! เพ่ือลดความเส่ียงตอการบาดเจ็บจากไฟฟาช็อตและ/หรือพ้ืนผิวที่รอน ควรถอดสายไฟออกจากเตารับที่
ผนัง และใหสวนประกอบภายในของเครื่องคอมพิวเตอรเยน็ลงกอนที่จะสัมผสั

ขอควรระวงั: เม่ือตอสายไฟกับเคร่ืองคอมพิวเตอร แหลงจายไฟจะมีแรงดนัไฟฟาสําหรับเมนบอรดอยูตลอดเวลา แม
วาเคร่ืองจะปดอยูก็ตาม หากคณุไมถอดสายไฟออก อาจเกิดความเสียหายแกระบบได

ไฟฟาสถิตอาจทําใหสวนประกอบอิเล็กทรอนิกสของคอมพิวเตอรหรือการดเสริมชํารุดเสียหายได กอนที่จะเร่ิมตน
กระบวนการเหลาน้ี โปรดตรวจสอบวาคณุไดคายประจุไฟฟาสถิตดวยการสัมผัสวัตถุที่เปนโลหะและมีการลงกราวด
โปรดดูคูมือ ขอมูลเก่ียวกับความปลอดภัยและขอบังคบัตางๆ เพ่ิมเติม

3. ถอดฝาครอบคอมพิวเตอรหรือแผงดานขาง

ขอควรระวงั: การสํารองขอมูลทําไดโดยเขาสูยูทิลิตีการตั้งคาคอมพิวเตอร ส่ิงสําคัญคือการสํารองขอมูลใน CMOS
ของคอมพิวเตอรกอนที่จะรีเซ็ต ในกรณีที่อาจตองการใชในภายหลัง การสํารองขอมูลทําไดโดยเขาสูยูทิลิตีการตั้งคา
คอมพิวเตอร โปรดดูรายละเอียดเก่ียวกับการสํารองขอมูล CMOS ใน คูมือยทูิลิตีการตั้งคาคอมพิวเตอร (F10)

4. หาตําแหนงปุม CMOS แลวกดคางไว 5 วินาที

หมายเหต:ุ ตรวจดใูหแนใจวาไดถอดสายไฟออกจากเตาเสียบที่ผนังแลว ปุม CMOS จะไมสามารถลบคาใน CMOS
ได หากยังเสียบสายไฟอยู

ภาพ B-1  ปุม CMOS

หมายเหต:ุ หากตองการคําแนะนําในการหาตําแหนงของปุม CMOS และสวนประกอบอ่ืนๆ ของเมนบอรด โปรดดูที่
แผนผงัชิ้นสวนและบริการพรอมภาพประกอบ (IPSM) สําหรับระบบของคุณ
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5. เปล่ียนฝาครอบคอมพิวเตอรหรือแผงปดเคร่ืองคอมพิวเตอร

6. ตออุปกรณภายนอก

7. เสียบปล๊ักและเปดเคร่ืองคอมพิวเตอร

หมายเหต:ุ หลังจากที่คุณลบคาใน CMOS และรีบูตระบบ จะปรากฏขอความแสดงขอผดิพลาด POST ซ่ึงระบุวามี
การเปลี่ยนแปลงคาคอนฟเกอเรชนั ใชยูทิลิตีการตั้งคาคอมพิวเตอรเพ่ือรีเซ็ตการตั้งคาพิเศษใดๆ ของระบบพรอมกับ
การตั้งวันที่และเวลา

สําหรับคําแนะนําเก่ียวกับการตัง้คาคอมพิวเตอร โปรดดู คูมือยทูิลิตีการตั้งคาคอมพิวเตอร (F10)
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C ระบบปองกันไดรฟ (DPS)

ระบบปองกันไดรฟ (DPS) เปนเคร่ืองมือในการวินิจฉัยทีมี่อยูในฮารดไดรฟที่ติดตั้งในเคร่ืองคอมพิวเตอรบางรุน DPS ได
รับการออกแบบมาเพื่อชวยวินิจฉัยปญหาที่อาจสงผลใหตองมีการเปลี่ยนฮารดไดรฟโดยไมอยูในเง่ือนไขการรับประกัน

เม่ือคอมพิวเตอรเหลาน้ีถูกสรางขึ้น ฮารดไดรฟที่ติดตั้งไวทุกตัวจะไดรับการทดสอบโดยใชระบบ DPS และจะมีการบันทึก
ขอมูลที่สําคัญไวอยางถาวรในไดรฟน้ันๆ และทุกคร้ังที่รัน DPS ผลการทดสอบจะถูกบันทึกลงในฮารดไดรฟ ผูใหบริการของ
คุณสามารถใชขอมูลน้ีเพ่ือชวยวินิจฉัยปญหาที่ทําใหคุณตองรันซอฟตแวร DPS

การรัน DPS จะไมมีผลตอโปรแกรมหรือขอมูลที่เก็บอยูในฮารดไดรฟ ขอมูลการทดสอบจะอยูในเฟรมแวรของฮารดไดรฟ
และสามารถรันไดแมวาคอมพิวเตอรจะไมสามารถบูตเขาสูระบบปฏิบัติการ เวลาที่ใชในการรันการทดสอบจะขึ้นอยูกับผูผลิต
และขนาดของฮารดไดรฟ แตโดยทั่วไปแลว การทดสอบจะใชเวลาประมาณ 2 นาทีตอกิกะไบต

คุณสามารถใช DPS เม่ือสงสัยวาฮารดไดรฟจะมีปญหา หากคอมพิวเตอรรายงานขอความ SMART Hard Drive Detect
Imminent Failure คุณไมจําเปนตองรัน DPS แตใหสํารองขอมูลไวในฮารดไดรฟและติดตอผูใหบริการเพ่ือขอ
เปล่ียนไดรฟ
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การเขาใช DPS จากโปรแกรมการตั้งคาคอมพวิเตอร
เม่ือคอมพิวเตอรไมเร่ิมตนอยางถูกตอง คณุควรใชโปรแกรมการตัง้คาคอมพิวเตอร เพ่ือเขาใชโปรแกรม DPS เม่ือตองการ
เขาใช DPS ใหปฏิบัติตามขั้นตอนตอไปน้ี:

1. เปดหรือเร่ิมตนระบบคอมพิวเตอรใหม

2. เม่ือขอความ F10 Setup ปรากฏขึ้นที่มุมขวาลางของหนาจอ ใหกดปุม F10

หมายเหต:ุ หากคุณไมไดกดปุม F10 ในขณะที่ขอความน้ันปรากฏอยู คณุจะตองปดคอมพิวเตอร กอนเปดขึ้นมาใหม
เพ่ือเขาสูยทูิลิตน้ีี

หัวขอสําหรับเลือกหาขอจะปรากฏในเมนูยทูิลิตีการตัง้คาคอมพิวเตอร: File, Storage, Security, Power และ
Advanced

3. เลือก Storage > DPS Self-Test

หนาจอจะแสดงรายชื่อฮารดไดรฟที่สามารถใช DPS ที่ติดตั้งอยูในระบบคอมพิวเตอร

หมายเหต:ุ หากไมมีฮารดไดรฟที่สามารถใช DPS ติดตั้งไว ตัวเลือก DPS Self-Test จะไมปรากฏบนหนาจอ

4. เลือกฮารดไดรฟที่ตองการทดสอบและปฏิบัติตามคําแนะนําบนหนาจอเพ่ือดําเนินการทดสอบใหเสร็จสมบูรณ

เม่ือการทดสอบเสร็จสมบูรณ ขอความใดขอความหน่ึงตอไปน้ีจะปรากฏขึน้:

● Test Succeeded. Completion Code 0.

● Test Aborted. Completion Code 1 or 2.

● Test Failed. Drive Replacement Recommended. Completion Code 3 through 14.

หากการทดสอบลมเหลว คุณควรบันทึกและรายงานรหัสขอผิดพลาดไปยังผูใหบริการเพ่ือขอรับความชวยเหลือในการวินิจฉัย
ปญหา
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